Contents

UNIT 1
NETWORKS AND COMMUNICATIONS
1.1 Computer Networks ........................................... 2
1.2 Cutting Edge Technologies ................................... 12
  Summary ......................................................... 16
  Exercise ......................................................... 18
  Lab Activities .................................................. 22

UNIT 2
COMPUTER SECURITY THREATS
2.1 Computer Security Threats ................................... 24
2.2 Managing an Antivirus ....................................... 30
  Summary ......................................................... 37
  Exercise ......................................................... 39
  Lab Activities .................................................. 42

UNIT 3
SPREADSHEETS IN EXCEL
3.1 Introduction to Spreadsheet ................................. 44
3.2 Formatting Worksheet Elements ............................ 64
3.3 Inserting Charts ............................................. 75
  Summary ......................................................... 79
  Exercise ......................................................... 82
  Lab Activities .................................................. 86

UNIT 4
PROBLEM SOLVING
4.1 Problem Solving ................................................ 90
4.2 Flowcharting .................................................. 92
  Summary ......................................................... 100
  Exercise ......................................................... 101
  Lab Activities .................................................. 104

UNIT 5
COMPUTER PROGRAMMING
5.1 Introduction to Programming ............................... 106
5.2 Programming in BASIC ..................................... 113
  Summary ......................................................... 129
  Exercise ......................................................... 131
  Lab Activities .................................................. 136

ANSWERS .......................................................... 137
GLOSSARY .......................................................... 141
BIBLIOGRAPHY .................................................... 148
INDEX ............................................................... 149

Prepared by: CH. GHULAM RASUL & SONS, Urdu Bazar, Lahore
Printed by: A. Y. Printers

Date of Printing Edition Copies Price
March 2018 1st 25200 71.00
After completing this unit, students will be able to:

- define computer network.
- know components of network.
- define a client and a server architecture.
- explain different types of networks like LAN, MAN and WAN.
- explain communication devices like Dialup Modem and NIC.
- explain physical transmission media (twisted pair cable, coaxial cable and fiber optic cable).
- explain
  - Cellular Communications
  - Satellite Communications
  - Global Positioning System
  - Bluetooth
Unit Introduction

The advancement in computer technology has revolutionized almost every aspect of our life. In earlier days, data was not shared among different computers or devices. Now data and information is being shared among computers. The sharing of data among computers is referred as Data Communication. This has increased the use of computers beyond the computer room. Data communication has enabled us to send and receive data and information from one computer to other computers.

Sharing of information from one computer to other computer is possible if these computers are connected or linked with each other as a network. This unit is dedicated to the computer networks and data communication.

1.1 Computer Networks

Most computer systems are now connected together in some way to form what is known as a network. This ranges from a basic school or home network of only a few computers to large networks such as the Internet.

1.1.1 What is a Network?

“A computer network is interconnection of two or more computer systems located in a same room, building or at different places”. Computer network enables the sharing of information, programs and hardware components. Figure 1.1 shows a computer network.

A computer network in an office, company or in a computer lab connects many computers and other devices such as printers with each other using cables.

Figure 1.1 Computer Network
Internet is a worldwide collection of networks which allows a subscriber to send and receive e-mails, chat or browse the World Wide Web (www) to get information on different topics.

1.1.2 Components of Computer Network

A computer network consists of the following four basic components:
- Sending Device
- Receiving Device
- Communication Devices
- Transmission Medium

![Diagram of a computer network](image)

*Figure 1.2 Components of Computer Network*

**Sending Device**

A device which is used to send messages, data or information to other devices connected to a network is called a sending device. In a computer network a sending device is usually a computer.

**Receiving Device**

In a computer network a receiving device receives messages, data or information from a sending device. The receiving device could be a computer, printer or a storage device.
**Communication Devices**

Communication devices are used for communication between the computers and other devices. Modem is a popular communication device which is used for Internet communication.

**Transmission Media**

Transmission Media is the channel or path through which the data or information is transferred from one place to another in a computer network. Networks are connected by wired or wireless transmission medium.

1.1.3 **Server and Clients**

In a computer network different computers perform different tasks or roles. According to these tasks and roles computers can be categorized as either clients or servers. Figure 1.3 shows a network containing a Server and Clients.

**Server**

Server is a powerful computer that facilitates the whole network by providing variety of services to the computer or devices connected to the network. These services may include:

- Processing data
- Storing information
- Controlling and managing network traffic, etc.
- User authentication
- Sharing software
**Client**

Client is a less powerful computer as compared to server computer. It relies on servers for resources, such as files, devices, and even processing power.

### 1.1.4 Types of a Computer Networks

On the basis of geographic distance, computer networks are categorized into the following three types:
- **LAN** (Local Area Network)
- **MAN** (Metropolitan Area Network)
- **WAN** (Wide Area Network)

**Local Area Network (LAN)**

A Local Area Network (LAN) is a network that is confined to a relatively small area. It is generally limited to a geographic area such as a building or adjacent buildings. LAN is the most common type of network. Local area networks are usually owned by one organization. Figure 1.4 shows a LAN.


**Advantages of LAN**

- Computers can share peripheral devices like printers, storage device, scanning devices, CD-ROM, etc.
- User can save their work centrally on the network server.
- Users can communicate with each other and transfer data between computers very easily. Application package such as a word processor, spreadsheet etc. in the server computer can be shared by all users.

**Disadvantages of LAN**

- Special security measures are needed to stop unauthorized users.
- LANs need to be maintained by skilled personnel.

**Metropolitan Area Network (MAN)**

A large computer network which extends to a city or to a metropolitan region is termed as Metropolitan Area Network or MAN. A MAN connects two or more LANs to form a network spread over the whole city.

Cable television network in a city is a good example of MAN. Figure 1.5 shows a Metropolitan Area Network connecting sub offices and home users to the head office.

*Figure 1.5 Metropolitan Area Network*
**Advantages of MAN**
- It is bigger than LAN.
- It transfers data at high speed.

**Disadvantages of MAN**
- It is expensive.
- It is difficult to maintain.

**Wide Area Network (WAN)**
Wide Area Network is a very large computer network covering a large geographic area, such as a state, province, country or the whole world. WANs often connect multiple smaller networks. Many large organizations develop their own private WAN's. An example of WAN is Internet. Figure 1.6 shows a WAN.
**Advantages of WAN**
- In WAN, the users at different locations are connected to a central server.
- It is used to monitor distant locations and offices.

**Disadvantages of WAN**
In WAN, security is a big issue.
- Setting up a network can be an expensive and complicated task.
- Management, maintenance and troubleshooting WAN is a difficult task.

**1.1.5 Communication Devices**
Most commonly used communication devices are:
- Dialup Modem
- Network Interface Card (NIC)

**Dialup MODEM**
A Dialup MODEM (Modulator-Demodulator) is a communication device. It is used to connect to the Internet, exchange information, and to send and receive data from one computer to the other. It translates computer information into a form that can be transmitted over telephone lines. Figure 1.7 shows the working of Modem.

![Figure 1.7 Working of Dialup Modem](image)
A modem can be located inside or outside the computer. Figure 1.8 shows different types of Modem.

Figure 1.8 Dialup Modems

In computers, information is stored digitally, whereas information transmitted over telephone lines is in the form of analog signals. Modem converts digital signals to analog signals (Modulation) and then analog signals to digital signals (Demodulation).

**Network Interface Card (NIC)**

Network Interface Card (NIC) is an expansion card that enables a computer to connect to a network. Each NIC has a unique serial number. This number is used to identify the computer on the network.

A Network Interface Card must be installed in each computer on the network. Figure 1.9 shows a Network Interface Card.

Figure 1.9 Network Interface Card

**1.1.6 Types of Physical Transmission Media**

The means through which data is transferred from one place to another is called transmission or communication media. There are three common types of physical transmission media or guided media.
Twisted Pair Cable

Twisted Pair cables are the most popular transmission media for transferring data on a computer network. They are especially used in Local Area Networks. Twisted pair wires consist of two strands of copper twisted together.

The twists allow the data signals to travel more as compared to a regular copper wire. The more twists per centimeter, the further the signal can travel. Twisted pair cable is of two types:

- **Unshielded Twisted Pair (UTP)**
  If the wires are unshielded, they are called Unshielded Twisted Pair cables, as shown in Figure 1.10(a).

- **Shielded Twisted Pair (STP)**
  If the wires are shielded, they are called Shielded Twisted Pair cables, as shown in Figure 1.10(b).

**Characteristics of Twisted Pair Cables**
- It is the least expensive type of cable.
- It is easy to install.

Do you know?

There are two types of transmission media:
Guided media is the transmission medium in which data/signal is guided by the cable or wire.
Unguided media or wireless media does not use any physical connectors between the two devices communicating.


**Coaxial Cable**

A type of wire that consists of a center wire surrounded by insulation and a shield of braided wire. The shield minimizes electrical and radio frequency interference.

Coaxial cabling is the primary type of cabling used by the cable television industry and is also widely used for computer networks. Plastic jacket, insulator, and braided shield in a coaxial cable ensure data transmission without interference from other cables. Coaxial cables are shown in Figure 1.11.
Characteristics of Coaxial Cable

- It is more expensive than standard telephone wire.
- It is much at risk of interference than twisted pair cable.
- Its data transfer rate is higher than twisted pair cable.
- It is easy to install.

Fiber Optic Cable

Fiber Optic is a type of cable that uses glass (or plastic) threads to transmit data. It consists of a bundle of glass threads, each of which is capable of transmitting messages in the form of light waves.

Fiber optic cable consists of a center glass core surrounded by several layers of protective materials such as cladding and Buffer coating as shown in Figure 1.12.

![Figure 1.12 Fiber Optic Cable](image)

Characteristics of Fiber Optic Cable

- It is more expensive as compared to other cables.
- It is difficult to install.
- The data transfer rate of fiber optic cable is the highest.

1.2 Cutting Edge Technologies

Cutting Edge Technology is the most advanced developments in the computer technology. The following are a few cutting edge technologies in the field of networks and communication.

- Cellular Communication
- Global Positioning System
- Satellite Communication
- Bluetooth
Cellular Communication

Cellular communication is a radio communication. It is distributed over a land area called Cell. Each Cell is served by at least one fixed-location transceiver known as a Cell Site or Base Station.

When joined together these Cells provide communication coverage over a wide geographic area.

Do you know?

The first mobile phone was presented by Dr. Martin Cooper of Motorola in 1973, whose weight was 2 kg.

GSM (Global System for Mobile) communication is a leading cellular Communication system.

The Cellular Communication system offers communication services to thousands of cell phone users. Figure 1.13 shows cellular communication.
**Satellite Communication**

Satellite Communication is a form of wireless communication in which satellites are the main objects. These satellites are commonly called communication satellites.

Communication satellites are ideally placed to provide the telecommunication links between different places across the globe.

These satellites enable us to communicate over large distances. Satellite communication can be used for many applications such as international telephone calls, providing communications to remote areas of the Earth, providing satellite communications to ships, aircraft and other mobile vehicles. Figure 1.14 shows satellites orbiting around the Earth.

**Global Positioning System**

The Global Positioning System (GPS) is global navigation satellite system. This position-finding system uses satellites to determine precise locations on the surface of the Earth.

GPS can be used to pinpoint any ship or submarine on the ocean, or to measure the height of Mount Everest. It can also be used by armed forces, scientists, fishermen, climbers, hikers and anyone who wants the accurate location and time information. Figure 1.15 shows GPS satellites with targets and GPS receiver. In this Figure, a stolen vehicle has been detected through Global Positioning System (GPS).
Bluetooth

Bluetooth is a wireless technology for exchanging data between different devices over short distances. It can connect several devices to communicate with each other wirelessly.

Networks are usually formed temporarily from portable devices such as cellular phones, handhelds computers and laptops.

Bluetooth offers service like file sharing, voice transport and for connecting devices like mouse, keyboard etc. Figure 1.16 shows Bluetooth sign.
A computer network is an interconnection of two or more computer systems located in a same room, building or at different places.

A device which is used to send messages, data or information to other devices connected to a network is called a sending device.

In a computer network a receiving device receives messages, data or information from a sending device.

Communication devices are used for communication between the computers and other devices.

Modem is a popular communication device which is used for Internet communication.

Transmission Media is the channel or path through which the data or information is transferred from one place to another in a computer network.

Networks are connected by wired or wireless transmission medium.

Server is a powerful computer that facilitates the whole network by providing variety of services to the computer or devices connected to the network.

Client is a less powerful computer as compared to server computer. It relies on servers for resources, such as files, devices, and even processing power.

A Local Area Network (LAN) is a network that is confined to a relatively small area.

A large computer network which extends to a city or to a metropolitan region is termed as Metropolitan Area Network (MAN).

Wide area network is a very large computer network covering a large geographic area, such as a state, province, country or the whole world.
A Dialup MODEM (Modulator-Demodulator) is a communication device used to connect to the Internet, exchange information, and to send and receive data from one computer to the other.

Network Interface Card enables a computer to connect to a network.

The means through which data is transferred from one place to another is called transmission or communication media.

Twisted Pair cables are the most popular transmission media for transferring data on a computer network.

Coaxial cable consists of a center wire surrounded by insulation and a shield of braided wire.

Fiber Optic uses glass (or plastic) threads to transmit data.

Cellular communication is a radio communication that offers communication services to thousands of cell phone users around the globe.

Satellite Communication is a form of wireless communication system in which satellites are ideally placed to provide telecommunication links between different places across the globe. These satellites enable us to communicate over large distances.

Bluetooth is a wireless technology for exchanging data between different devices over short distances.

The Global Positioning System (GPS) is a global navigation satellite system. This direction-finding system uses satellites to determine precise locations on the surface of the Earth.
Q1. **Tick the correct choice for the following questions.**

i. A computer network is interconnection of two or more__________.
   - a. Printers
   - b. Monitors
   - c. Computers
   - d. Hard disks

ii. The data is transferred from one place to another through__________.
   - a. Mouse
   - b. Keyboard
   - c. Storage device
   - d. Transmission media

iii. Which of the following is a communication device?
   - a. Mouse
   - b. Modem
   - c. Monitor
   - d. Printer

iv. Which device is used to send messages, data or information to other devices?
   - a. Receiving device
   - b. Sending device
   - c. Communication device
   - d. Input device
v. Which of the following network is confined to a relatively small area?
   a. Internet
   b. WAN
   c. MAN
   d. LAN

vi. In WAN, “W” stands for ________
   a. Width
   b. Wire
   c. Wide
   d. Whole

vii. Which is a powerful computer that facilitates the whole network by providing variety of services to the computer or devices connected to the network?
   a. Server
   b. Client
   c. PC
   d. Laptop

viii. ___________ is an expansion card that enables a computer to connect to a network.
   a. Network Interface Card
   b. VGA Card
   c. FAX Card
   d. Sound Card

ix. ___________ is a type of wire that consists of a center wire surrounded by insulation and then a grounded shield of braided wire.
   a. Fiber Optic
   b. UTP
   c. STP
   d. Coaxial cable
x. Which of the following is the fastest transmission media?
   a. UTP cable
   b. STP cable
   c. Fiber optic cable
   d. Coaxial cable

Q2. Fill in the blanks.
   i. A computer network consists of _______ basic components.
   ii. In a computer network a _______________ device receives messages, data or information from a sending device.
   iii. _______________ is the channel or path through which the data or information is transferred from one place to another in a computer network.
   iv. ___________ is a less powerful computer as compared to server computer that relies on servers for resources.
   v. MAN stands for ________________________________.
   vi. _______________ is a very large computer network covering a large geographic area, such as a state, province, country or the whole world.
   vii. NIC stands for _________________________________.
   viii. ___________ is a wireless technology for exchanging data between different devices over short distances.
   ix. _______________ is a type of cable that uses glass (or plastic) threads to transmit data.
   x. _______________________________ is global navigation satellite system.
### Q3. Match Column A with Column B.

<table>
<thead>
<tr>
<th>Column A</th>
<th>Column B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sending Device</td>
<td>Coaxial Cable</td>
</tr>
<tr>
<td>Communication Device</td>
<td>NIC</td>
</tr>
<tr>
<td>Transmission Media</td>
<td>Glass threads</td>
</tr>
<tr>
<td>Network</td>
<td>A Computer</td>
</tr>
<tr>
<td>Fiber Optic</td>
<td>Modem</td>
</tr>
</tbody>
</table>

### Q4. Give brief answers to the following questions.

i. Define the following terms:
   a. Data communication
   b. Cellular Communication
   c. Satellite Communication
   d. Fiber optic cable

ii. Name different types of transmission media.

iii. How a Modem works? Show diagrammatically.

iv. Differentiate between LAN and WAN.

v. What is Satellite Communication?

### Q5. Give detailed answers to the following questions.

i. Explain different types of physical transmission media.

ii. Explain different types of computer networks.

iii. Describe the following cutting edge technologies:
   a. GPS
   b. Bluetooth

iv. Discuss different components of a computer network.

v. What are communication devices? Explain any two of them.
LAB ACTIVITIES

Lab Activity 1
Make a chart showing different types of Computer Networks and paste it in your Computer Lab.

Lab Activity 2
Observe your School Computer Lab and find what type of Computer Network exists in your Lab.

Lab Activity 3
Which transmission media and communication devices are used in your School Lab Computer Network? Draw their shapes in your notebooks.

Lab Activity 4
Observe and find information, how computers and other devices are connected to each other in your School Computer Lab.
After completing this unit, students will be able to:

- define
  - Virus
  - Worms
  - Adware
  - Hacker
- know that a virus, worm and adware can spread through
  - Infected flash drives or disks
  - E-mail attachments
  - Surfing insecure websites
  - Installing pirated software
- define
  - Antivirus
  - Virus definitions / Updates
- know the following widely used antivirus software
  - Symantec
  - McAfee
  - AVG
- scan a computer for viruses.
Unit Introduction

Computer systems are in danger of many threats that can cause various types of harms, resulting in significant losses. This unit will discuss the common types of computer security threats, the ways through which computer infection spreads to other computers and techniques to prevent computers. Students will also learn how to scan computers to detect and get rid of malicious programs.

2.1 Computer Security Threats

Computer security threat may be a computer program, an event or even a person which causes loss of data, affect the working of a computer and stealing of information.

2.1.1 Types of Threats

Computer systems are vulnerable to many threats ranging from errors, harming stored data, information or corrupting programs installed on the computers. The following are some common types of threats to computers:

- Virus
- Worms
- Hackers
- Adware

Virus

Computer virus is the most common and well known computer security threat. A computer virus is a program written intentionally to alter the way a computer operates, without the permission or knowledge of the user.

A virus replicates and executes itself by attaching copies to other files such as program files or documents so that the user clicks them and the virus activates.

Figure 2.1 Messages due to a Virus
When activated a virus may:

- Damage or delete files
- Cause erratic system behaviour
- Erase data in hard disk
- Display annoying messages, etc.

Examples of Viruses are: NYB, AntiExe, Cascade, FRODO, Win95 and Zmist A, etc. Figure 2.1 shows an alert message caused by a virus and Figure 2.2 shows some virus infected files.

**Worms**

Computer worms are malicious programs that replicate and spread independently without user action and harm the computer. Worms spread through network and over the internet to computers that are connected to the Internet.

Worms can also spread by copying themselves from disk to disk or by e-mail. SQL Slammer, The Blaster Worm, Sasser worms, Melissa and ILOVEYOU are examples of computer worms.
Computer Worms can:
- Destroy files in the system
- Slow down the computer
- Cause some programs to stop working

**Adware**

Adware is a software which automatically plays, displays, or downloads advertisements to a computer usually without user's knowledge. These advertisements can be in the form of a pop-up. They record user's behaviour on the Internet, display ads and can even download other malicious software on to the computer.

They may also be in the user interface of the software or on a screen presented to the user during the installation process. Figure 2.3 shows an Adware message which may be harmful when activated.
Hackers

Hacking can be defined as the unauthorized use of computer, network and its resources. People who indulge themselves in computer hacking activities are called Hackers. Hackers are computer experts who use their expertise for malicious purposes.

Hacker Steals

- Client or customer information
- Credit card details and social security numbers, for identity fraud or theft
- Passwords
- E-mail addresses, which may be used for spamming.

Indicators of Security Threats

- The computer runs slower than usual.
- The computer locks up or stops responding.
- The computer suddenly restarts on its own.
- Frequently used programs become suddenly slow to load and operate.
- Applications and disk drives are suddenly inaccessible.
- Unusual error messages appear.
- Unexpected icons appear on the desktop.
- Antivirus software is disabled or does not run.

2.1.2 Ways through which Virus, Worms and Adware Spread

There are different ways through which a Virus, Worms and Adware spread from one computer to the other computer.

A Virus, Worms and Adware can spread through:

- Infected Flash Drives or Disks
- Surfing insecure websites
- E-mail attachments
- Installing Pirated Software
Infected Flash Drives or Disks

Flash drives and disks are convenient, popular and easy to use storage devices. Flash drives and disks are the main source of spreading viruses among computers. Once an infected flash drive or a disk is connected to a healthy computer, it becomes infected with viruses. In this way virus spread from one computer to the other.

E-mail Attachments

E-mail attachment is a file that can be sent with an e-mail from one computer to the other. An e-mail virus is a computer code sent as an e-mail attachment. If activated, it may cause some harmful effect, such as destroying certain files on the hard disk and causing the attachment to be forwarded to everyone in the address book. E-mail viruses distribute themselves automatically by e-mail.

These viruses require the user to double-click on the attachment containing viruses. This causes the malicious code to mail itself to other people from that computer.

The best defense against e-mail viruses is to never open an unknown e-mail. Figure 2.4 shows an e-mail attachment threat.

Figure 2.4 E-mail Viruses
**Surfing Insecure Websites**

A Website that is set up to spread a virus or for some other unethical purpose is an insecure website. These websites engage in questionable or unethical practices and attempt to:

- Automatically access the computer when users visit them.
- Install Adware that may cause a flurry of pop ups to appear on the screen.

Figure 2.5 shows an alert message about an insecure website.

![Figure 2.5 Infected Website](image)

**Installing Pirated Software**

Software which has been duplicated and distributed without authorization is called Pirated software. Pirated software may be faulty or loaded with malware and may contain viruses.

Pirated software can threaten the safety of computer users. These software products may be used to steal personal information, load a computer with viruses, or engage in activities which can harm the computer.
2.2 Managing an Antivirus

Computer and internet users need to have the latest antivirus software programs installed on their computers. Antivirus software plays an important role in computer safety, as it can protect documents and files from becoming damaged or lost due to viruses.

Managing an antivirus means how to detect and eliminate potential virus threats by efficiently using antivirus software. This can be accomplished by the computer security program on the computer scanning any files looking for virus definitions that match a virus dictionary.

If a matching virus is found, the software alerts the user about the virus and takes necessary action and gets rid of the infected files.

2.2.1 Antivirus and Virus Definitions / Updates

Antivirus

Antivirus software is a computer program that detects, prevents, and takes action to deactivate or remove malicious programs (Viruses, Worms, Adware, etc.).

Antivirus program runs in the background all the time and informs the user when some malware is detected.

Antivirus software protect computer connected to the networked computers.

Some examples of antivirus software are:
- Symantec Antivirus software
- McAfee software
- AVG Antivirus
- Kaspersky
- BitDefender
- Nod32
Virus Definitions / Updates

Virus Definitions contain the information about malware which can be used to identify security threats. While scanning a computer, Virus Definitions tell the antivirus software to recognize viruses. When antivirus software is installed, a file containing a set of virus definitions file is also installed.

To protect the computer from the most current viruses, user must update antivirus software regularly. Most antivirus programs include an Auto-Update feature that enables the antivirus program to download profiles of new viruses so that it can check for the new viruses as soon as they are discovered.

An Antivirus Update is an upgradation of already installed antivirus software. Update virus definitions can protect and clean the computer from the most recent computer viruses and other security threats. Figure 2.6 shows virus definition update file downloading process.
2.2.2 Widely Used Antivirus Software

Everyday new viruses are spreading and infecting millions of computer across the world. For all computer users, it is very important to have proper antivirus program installed in their computers to secure the data and programs.

Following are some widely used antivirus programs.

- Symantec Antivirus (SAV)
- McAfee Antivirus
- AVG (Antivirus Guard)

**Symantec Antivirus**

Symantec Corporation is the largest maker of security software for computers. Symantec Antivirus (SAV) is a very powerful effective program, which can protect computers from different kinds of safety issues.

Figure 2.7 shows SAV software pack while Figure 2.8 gives an imagination how SAV protects a computer from various threats.

Following is a list of features of Symantec Antivirus software:

- Symantec Antivirus (SAV) performs virus scanning both on-demand and real-time in the background while using the computer.
- Protects a computer against the latest viruses, spyware, and other threats.
- Lets users chat, e-mail and share files without worry.
- A quarantine feature isolates infected files in a safe area on the computer until they are repaired.
- The Live Update feature ensures that the SAV scanner always has the latest Virus Definitions.
**McAfee Antivirus**

McAfee Virus Scan is an antivirus program created and maintained by McAfee Incorporation. McAfee antivirus offers effective security to the computer from attacks of malware.

*McAfee Virus Scan Enterprise* combines antivirus, anti-spyware, firewall, and hacking prevention technologies to stop and remove malicious software. Figure 2.9 shows a message from McAfee antivirus.

![Figure 2.9 McAfee Antivirus](image)

**AVG Antivirus**

AVG is antivirus software developed by AVG Technologies, a private Czech company formerly known as Grisoft. It provides Internet security for the Windows, Linux and Mac OS X. AVG stands for Antivirus Guard.

One version of AVG is available for free which can be downloaded from the Internet.

![Figure 2.10 AVG Antivirus Logo](image)

The AVG Free Edition application provides basic protection for surfing, searching and social networking. AVG Anti-Virus Free Edition is only available for single computer use for home and non-commercial use.

In AVG, updating of virus definitions is performed automatically. Figure 2.10 shows AVG antivirus logo.
2.2.3 Scanning a Computer for Viruses

Scanning the computer for threats like viruses, worms, adware, etc. is very important to keep a computer system in good working condition. It helps to protect a computer from different computer security threats.

User needs to install antivirus software on the computer to perform this very important task. The antivirus software enables the user to detect and remove computer viruses and also repair infected files if possible.

**Scanning Computer Using AVG Antivirus**

Follow these steps to scan the computer using AVG antivirus software:

Run AVG antivirus software using the following steps:

- Click Start ⇒ Programs ⇒ AVG Free Edition ⇒ AVG Antivirus Free Edition for Windows
- Click "Update Manager" for updates, as shown in Figure 2.11 (Internet connection is required). Always check for updates before scanning computer.

![Figure 2.11 AVG Update Manager](image)
Once you start the update, AVG will first verify whether there are new update files available. If so, AVG starts their downloading and launches the update process itself. Once it finishes downloading the update, it will install it, and may restart AVG Free Edition.

- Click "Scan now", as shown in Figure 2.12. It will then start scanning the computer for infected files. This will take some time.

![AVG Scanning Interface](image)

*Figure 2.12 AVG Scanning Interface*

- The “Whole computer scan” option can be launched directly from the scanning interface by clicking on it, as shown in Figure 2.13. The scanning will start.
If viruses are detected, they will be automatically removed or sent to the "Virus Vault" as shown in Figure 2.14.
Computer security threat may be a computer program, an event or even a person which causes loss of data, affecting the working of a computer and stealing of information.

Computer systems are vulnerable to many threats ranging from errors, harming stored data, information or corrupting programs installed on the computers.

Some common types of threats to the computers are Virus, Worms, Hackers and Adware.

Computer virus is the most common and well known computer security threat. A computer virus is a program written intentionally to alter the way a computer operates, without the permission or knowledge of the user.

Computer worms are malicious programs that replicate and spread independently and harm the computer.

Adware is a software which automatically plays, displays, or downloads advertisements to a computer usually without user's knowledge. These advertisements can be in the form of a pop-up.

Hacking is the unauthorized use of computer, network and its resources.

People who indulge themselves in hacking activities are called hackers.

There are many different ways through which a Virus, Worms and Adware spread from one computer to the other computer like 'Infected flash drives or disks', 'E-mail attachments', 'Surfing insecure websites' and 'Installing Pirated Software', etc.

Flash drives and disks are the main source of spreading viruses among computers.
An e-mail virus is a computer code sent as an e-mail attachment.

A website that is set up to spread a virus or for some other unethical purpose is an insecure website.

Software which has been duplicated and distributed without authorization is called Pirated software. Pirated software may be faulty or loaded with malware and may contain viruses.

Managing an antivirus means how to detect and eliminate potential virus threats by efficiently using antivirus software.

Antivirus software is a computer program that detects, prevents, and takes action to deactivate or remove malicious programs (Viruses, Worms, Adware, etc.).

Virus Definitions contain the information about malware which can be used to identify security threats.

Some widely used antivirus programs are Symantec Antivirus (SAV), McAfee Antivirus and AVG (Antivirus Guard).

Symantec Corporation is the largest maker of security software for computers. Symantec Antivirus (SAV) is a very powerful effective program, which can protect computers from different kinds of safety issues.

McAfee Virus Scan is an antivirus program created and maintained by McAfee Incorporation. McAfee antivirus offers effective security to the computer from attacks of malware.

AVG is antivirus software developed by AVG Technologies, a private Czech company formerly known as Grisoft. It provides Internet security for the Windows, Linux and Mac OS X. AVG stands for Antivirus Guard.

Scanning the computer for threats like viruses, worms, adware, etc. is very important to keep a computer system in good working condition. It helps to protect a computer from different computer security threats.
Q1. **Tick the correct choice for the following questions.**

i. Which of the following is a malicious program that replicates and spreads independently and harms the computer?
   a. Virus
   b. Worm
   c. Adware
   d. Spyware

ii. Which malicious program records users' behaviour on the Internet, display ads and can even download other malicious software on to the computer?
   a. Virus
   b. Spyware
   c. Adware
   d. Worm

iii. A website that is set up to spread a virus or for some other unethical purpose is called an ________________.
   a. Secure Website
   b. Non-informative website
   c. Informative website
   d. Insecure website

iv. Which of the following is a computer program that detects, prevents, and takes action to deactivate or remove malicious programs?
   a. Virus program
   b. Operating system
   c. Antivirus program
   d. Word processor
v. _______________ contains the information about malware which can be used to identify them.
   a. Virus definition file
   b. Word file
   c. Excel file
   d. E-mail attachment

vi. Which of the following is a common source of spreading viruses in computers?
   a. Infected flash drives or disks
   b. E-mail attachments
   c. Surfing insecure websites
   d. Installing Pirated Software

vii. _______________ is the unauthorized use of computer, network and its resources.
   a. Programming
   b. Hacking
   c. Stealing
   d. Robbing

Q2. **Fill in the blanks.**

i. An e-mail virus is a computer code sent as _________________ to other computers.

ii. People who indulge themselves in hacking activities are called ____________.

iii. Some common types of _________ to the computers are Virus, Worms, Hackers and Adware.

iv. Software which has been duplicated and distributed without authorization is called ____________ software.

v. _______________ is software which automatically plays, displays, or downloads advertisements to a computer usually without user's knowledge.
### Q3. Match Column A with Column B.

<table>
<thead>
<tr>
<th>Column A</th>
<th>Column B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virus</td>
<td>Current viruses</td>
</tr>
<tr>
<td>Hacker</td>
<td>Malicious program</td>
</tr>
<tr>
<td>Pirated Software</td>
<td>Adware</td>
</tr>
<tr>
<td>Virus definitions</td>
<td>Steals Password</td>
</tr>
<tr>
<td>Antivirus</td>
<td>AVG</td>
</tr>
<tr>
<td></td>
<td>Illegal copying</td>
</tr>
</tbody>
</table>

### Q4. Give brief answers to the following questions.

i. List some effects / indicators of security threats.
ii. Differentiate between a virus and a worm.
iii. How viruses and worms spread through e-mail attachments?
iv. Who is a hacker? What can a hacker do?
v. How Adware affect the working of a computer?
vi. Name the different types of viruses.
vii. What is an Antivirus?

### Q5. Give detailed answers to the following questions.

i. Explain different threats to the security of a computer.
ii. Explain various ways through which security threats spread in computers.
iii. Give the steps to update the virus definition of antivirus software.
iv. What is meant by scanning computer and what are the steps to scan a computer?
v. What is meant by virus definitions / updates? Why they are important? Explain.
Note which computer antivirus program is installed in computers of your school computer Lab.

Run antivirus program and see if the virus definition file is up-to-date or not.

Run manual virus definition update feature and update if new virus definitions are available.

Scan your computer with antivirus and note what different viruses are detected.

Attach a USB Flash Drive and scan it for viruses.
After completing this unit, students will be able to:

- define spreadsheet.
- know the purpose of spreadsheet.
- explain workbook and worksheet.
- identify
  - Columns  Rows  Cells  Cell address
- manipulate data (numeric and non-numeric) into a cell / range of cells by
  - Entering data  Editing data  Auto filling data
- enter a formula.
- insert functions
  - SUM  PRODUCT  AVERAGE  POWER
  - SQRT  MAX  MIN
- create a spreadsheet such as monthly report of expenses, students result sheet and salary report, etc.
- save a spreadsheet.
- select a cell / range of cells to
  - Cut/copy  Paste
  - Format text
    - Font  Font size  Font style
    - Font colour  Alignment
- applying borders and shading to a cell / range of cells.
- insert new rows / columns.
- use chart wizard to insert
  - Column chart  Line chart  Pie chart
Unit Introduction

Spreadsheet is one of the widely used application package installed in the computers to manage data in rows and columns. In this unit, students will learn about the spreadsheet package – Excel.

They will learn to manipulate data (numeric and non-numeric) in the cells available in spreadsheet. This unit will explain how to perform different arithmetic operations on data and convert it to graphical form.

3.1 Introduction to Spreadsheet

A spreadsheet is a computer application which is used to display data in multiple cells usually in a two-dimensional matrix or grid consisting of rows and columns. Each cell contains numeric or non-numeric data, formulae or functions.

Spreadsheet are frequently used for financial information because of their ability to recalculate the entire sheet automatically after a change to a single cell is made. Microsoft Office Excel 2007 is spreadsheet software.

3.1.1 Spreadsheet

Spreadsheet is a computer program used to enter, analyze, and calculate data for record keeping. It stores and presents data in rows and columns. Data can easily be entered, modified and deleted from it. It performs mathematical calculations and projections based on data entered. Common spreadsheet uses include analysis, charting, and budgeting, etc.

3.1.2 Purpose of Spreadsheet

Spreadsheet are used in different fields for variety of purposes like accounting, budgeting, charting / graphing, financial analysis and scientific applications, etc.
Spreadsheet is used to:

- Store and maintain data in a tabular form.
- Manipulate and calculate data by using various functions and formulae.
- Perform complex mathematical calculations.
- Recalculate formula automatically whenever a value is changed or modified.
- Create charts / graphs to represent data.
- Process and display needed information by sorting and filtering entries according to established criteria.

### 3.1.3 Spreadsheet Software – Excel

Excel is one of the popular and commonly used spreadsheet software. Excel can be used from home to professional level to perform calculations on data, creating mailing lists and creating budgets, etc.

Excel is an electronic spreadsheet program that can be used for storing, organizing and manipulating data. Excel screen is in the form of a rectangular table or grid of rows and columns. The horizontal rows are identified by numbers (1, 2, 3, …) and the vertical columns with alphabet (A,B,C or AA, AB, etc).

### 3.1.4 Workbook and Worksheet

#### Workbook

A workbook is a file created by Excel spreadsheet application. Excel workbook consists of spreadsheet 'pages', each of which can include separate data. MS Excel 2007 Workbook is stored with extension ‘.xlsx’. One workbook may contain many worksheets.

#### Worksheet

Worksheet (also known as a spreadsheet) is a single page in workbook. It is a collection of cells on a single “sheet” where user keeps and manipulates the data. Worksheets in a workbook can be accessed by the sheet tabs located at the left corner of Excel window. By default three worksheets are provided in a
workbook to enter data. More worksheets can be added as and when required in a workbook.

### 3.1.5 Excel Application Window

User can start Excel program as follows:

- Click **Start**
- Select **All Programs**
- Point to **Microsoft Office**
- Click **Microsoft Office Excel 2007**
- Excel window appears as shown in Figure 3.1

![Figure 3.1 Excel Window](image-url)
Components of Excel Window

The Excel 2007 window is made up of the several components discussed as follows:

Office Button

The Office Button is at the top left of the Excel window. Clicking this button opens a menu of commands.

Recent documents can be seen on the right of the Office Button menu. Figure 3.2 shows Office Button menu with commands.

Quick Access Toolbar

Next to the Microsoft Office Button is the Quick Access Toolbar. The Quick Access Toolbar gives access to frequently used commands. By default, Save, Undo, and Redo appear on the Quick Access Toolbar.

Title Bar

It is located at the top of the Excel window. On the Title bar, Microsoft Excel displays the name of the workbook currently used.

User could see "Book1 - Microsoft Excel" at the right side of the Quick Access Toolbar of Excel window.

On the right side of Title bar are three control buttons: Minimize, Restore or Maximize, and Close buttons to control the window.
**Ribbon**

The Ribbon, as shown in Figure 3.3, is located below the Quick Access toolbar. The commands on the Ribbon are organized in seven tabs and each tab is divided into groups which have buttons of related commands.

**Formula Bar**

Formula bar displays the contents of the active cell and the formulae as user types them in an active cell. The formula bar can be used to edit cell’s content easily. The formula bar also contains the Insert Function button used to guide the user through the creation of mathematical formulae. Figure 3.4 shows Formula bar.

**Name Box**

Name Box displays the reference of the active cell. It is located next to the formula bar, as shown in Figure 3.5.

It can also be used to go to a specific cell by entering the name of the cell in it.

**Document (Worksheet) Window**

The document (worksheet) window contains an Excel workbook that consists of a number of worksheets. A worksheet is a document window where user can enter data and modify it. The worksheet is made up of rows and columns. Intersection of a row and a column is called a cell. The name of the cell is made up of the column name and the row number, for example, A1 is the cell in column A and row 1.
At the bottom of each worksheet is a numbered sheet tabs. It has the name of the worksheet on it, which can be changed. Sheet tab can be used to bring the worksheet to the front. Figure 3.6 shows a document window.

**Sheet Tabs**

Sheet tabs, as shown in Figure 3.7, are used to access different worksheets in a workbook. By default three sheet tabs are available in a workbook. User can add more tabs as required by using mouse right click menu and selecting the 'Insert' option followed by 'worksheet' option. User can also change the tabs name to easily identify the data entered in the sheet using right click menu.
3.1.6 Basic Elements of Worksheet

The following are basic elements of a worksheet.

**Columns**

Columns in a worksheet are arranged vertically. They are identified by alphabet in the column header from A to Z, AA, AB, AC, to XFD, as shown in Figure 3.8.

**Rows**

Rows are arranged horizontally in a worksheet. They are identified by numbers in the row header (1, 2, 3, 4, …), as shown in Figure 3.8.

**Cell**

The intersection of row and column in a worksheet is called cell. Cell is the basic unit in the worksheet where user can enter data, function or formula. The **active cell** is the cell which is currently selected. It can be identified by the black border around it, or by its cell address in the Name Box. Figure 3.8 shows cell and active cell (C6).

**Cell Address or Cell Reference**

Cell Address or Cell Reference identifies the location of a cell or group of cells in a worksheet. It consists of the column letter and row number that intersect at the cell's location. Cell references are used in formulae, functions, charts, and other Excel commands. Figure 3.8 shows cell address of the active cell as C6.
Cell Range

Selecting more than one cell is known as a cell range. Two cell references are used for a range of cells separated by a colon (:) which tells Excel to include all the cells between the start and end points. Figure 3.9 shows range of cells from C4 to F7.

![Figure 3.9 Cell Range](image)

3.1.7 Data Manipulation

Data manipulation involves entering, editing and formatting data. Different formulae and functions can also be applied to manipulate data. User should enter some data before manipulation.

Entering Data

To enter data:

- Click a cell to select it. As user selects a cell, the cell address appears in the Name Box.
- Enter text into the cell using the keyboard. The text appears in the cell and in the formula bar as shown in the Figure 3.10.
- Two buttons also appear in the Formula bar, the cancel button.
- When the user has completed typing data, it can be entered permanently into the active cell by pressing ENTER or by clicking the mark in the Formula Bar or by pressing the TAB key on the keyboard.
- User can enter data anywhere in the worksheet by moving to the required cell, using the mouse or arrow keys, and typing the text.

![Figure 3.10 Entering Data](image)

**Editing Data**

Editing data means doing any changes in it.

**To Edit Data:**
- Click on the cell and retype the text OR
- Go to the Formula Bar, select the incorrect text with the mouse and re-type it.

**Auto Filling Data**

Auto filling is the use of the fill-handle to copy data and sequences across a range of cells. The fill-handle is at the right corner of each cell, as shown in Figure 3.11.
To Fill a Range of Cells:

- Select the cell with the content to fill.
- Point at the black square that appears in the bottom right corner of the cell, until the mouse pointer becomes the fill handle.
- Click and drag in the direction of the range to fill.

Figure 3.11 shows auto filling of even numbers in Column C from 2 to 16.

![Figure 3.11 Auto filling](image)

Excel copies the contents of the cell across the range that user selects. This feature becomes very powerful when used with cells containing formulae. A lot of time can be saved by copying formulae across a range of cells.

### 3.1.8 Entering a Formula

A formula is an equation that performs a calculation using values in the worksheet. A formula always begins with an equals sign followed by either values or cell references and an operator.

Example:

\[= 23 + 29\]
\[= D8 + F9 - E9\]
To enter a simple formula that adds two numbers in two cells:

Follow these steps:

- Click the cell where the formula will be entered (For example D3), as shown in Figure 3.12
- Type the equal sign (=) to let Excel know a formula is being defined.
- Click on the first cell containing a number (For example B3), as shown in Figure 3.12
- Press the addition sign (+) key to let Excel know that an add operation is to be performed.
- Click on the second cell containing a number (For example C3), as shown in Figure 3.12
- Press Enter or click the Enter button on the Formula bar to complete the formula.

![Figure 3.12 Entering Formula](image)

**Mathematical Operators:**

The following mathematical operators are used to perform different operations in formulae.

---

**Unit 3 | Spreadsheets in Excel**
3.1.9 Inserting Functions

Functions are pre-defined or built-in formulae. Different types of functions are available in Excel. These functions can be used for different calculations. Functions can be located from Formulas tab or by clicking on Insert Function option in formula bar or by typing the function manually. Figure 3.13 shows different locations of function application.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Purpose</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Performs addition</td>
<td>=A1+A2</td>
</tr>
<tr>
<td>−</td>
<td>Performs subtraction</td>
<td>=C4−C5</td>
</tr>
<tr>
<td>*</td>
<td>Performs multiplication</td>
<td>=C4*D4</td>
</tr>
<tr>
<td>/</td>
<td>Performs division</td>
<td>=B1/C1</td>
</tr>
</tbody>
</table>

Each function has a specific order as follows:
- All functions begin with the = sign.
- After the = sign, the function is inserted (e.g., =Sum).
- Then there will be an argument.

An argument is the cell range or cell references that are enclosed by parentheses. If there is more than one argument, separate each by a comma.

An example of a function with one argument that adds a range of cells A3 through A9. Some commonly used functions are as follows:

**SUM()**

The SUM function adds all the numbers that user specifies as arguments. Each argument can be a range, a cell reference, an array, a constant, a formula, or the result from another function.

For example =SUM(B5:B9) adds all the numbers that are contained in cells B5 through B9, as shown in Figure 3.14

**PRODUCT()**

The PRODUCT function multiplies all the numbers given as arguments and returns the product.

For example in cell A4 the function =PRODUCT(A1, A2) is used to multiply two numbers in cells A1 and A2, as shown in Figure 3.15
**AVERAGE()**

AVERAGE function returns the average (arithmetic mean) of the arguments. For example, if the range B1:B5 contains numbers, the formula **=AVERAGE(B1:B5)** returns the average of those numbers, as shown in Figure 3.16.

**POWER()**

POWER function returns the result of a number raised to a power. Its general form is:

**=POWER (number, power)**

- **Number** is the base number. It can be any real number.
- **Power** is the exponent to which the base number is raised.

Example: The function **=POWER(55,3)** is used to find the value for 55 raised to the power 3, as shown in Figure 3.17.

**Do you know?**

If number is negative, SQRT function returns the #NUM! error value.
**SQRT()**

SQRT function calculates the square root of a given number. Its general form is:

= SQRT(number)

Number is the number for which the square root is needed.

Example:

The function =SQRT(256), finds the square root value of the number 256, as shown in the Figure 3.18

**MAX()**

The MAX function returns the largest value from a supplied set of numerical values. Its general form is:

= MAX(number1, [number2], ...)

Where, the number arguments are a set of one or more numeric values to return the largest value of them.

Example:

The function =MAX(A1:E1) in cell B3 return the maximum value, as shown in the Figure 3.19.

**MIN()**

The Excel MIN function returns the smallest value from a supplied set of numerical values. The general form of the function is:

= MIN(number1, [number2], ...)

Where, the number arguments are a set of one or more numeric values.
Example:
The function =MIN(A1:E1) in cell B3 return the minimum value, as shown in the Figure 3.20.

![Figure 3.20 MIN Function](image)

### 3.1.10 Creating Different Spreadsheets

The following steps are used to create a new spreadsheet.

- Click the Microsoft Office Button.
- Select New command, as shown in Figure 3.21
- The new workbook dialog box opens and blank workbook is highlighted by default, as shown in Figure 3.22
- Click Create. A new, blank workbook appears in the window.

![Figure 3.21 New Command](image)
OR

- When a user first opens Excel, the software opens to a new, blank workbook.

**Sample Spreadsheets**

- Monthly Expense Report
- Monthly Salary Report
- Result Sheet

**Creating Monthly Expense Report**

- To create monthly expense report, follow these steps:
  - Open MS Excel.
  - Double click on Tab Sheet1 and type “Monthly Exp”.

- Click on A1 and type “Monthly Expense Report”
● Click on A2 and type “Date”
● Click on B2 and type “Particulars”
● Click on C2 and type “Amount”.
● Type the relevant data for Date, Particulars and Amount under the above headings from A3 to C10.
● Click on B11 and type “Total Expenses”.
● Click on C11 and type “=SUM (C3 : C10)”.
● Figure 3.23 shows a monthly expense report.

**Creating Monthly Salary Report**

Double click on Tab Sheet2 and type Salary Rep.

● Click on A1 and type “XYZ COMPANY”.
● Click on A2 and type “Salary Rep”.
● Click on A3 and type “JANUARY”.
● Click on A5 and type “Name”.
● Click on B5 and type “Basic Salary”.
● Click on C5 and type “House Allowance”.
● Click on D5 and type “Medical Allowance”.
● Click on E5 and type “Gross Salary”.
● Click on F5 and type “Tax 3% Deduction”.
● Click on G5 and type “Net Salary”.
● Type data under the above headings.
● Click on E6 and type “=SUM (B6:D6)”.
● Copy the SUM function on the E7 to E11 by the Auto Fill command of Excel.
Click on F6 and type “= 3%*E6”.
Copy the “= 3%*E6 formula on the F7 to F11 by the Auto Fill command of Excel.
Click on G6 and type “= E6 – F6”.
Copy the = E6 – F6 formula on the G7 to G11 by the Auto Fill command of Excel.
Figure 3.24 shows a monthly salary worksheet of XYZ COMPANY.

Figure 3.24 Monthly Salary Worksheet

Creating Monthly Result Sheet

Double click on Tab sheet3 and type “Result Sheet.”
Click on A1 and type “XYZ SCHOOL”.
Click on A2 and type “Monthly Result Sheet”.
Click on A3 and type “January”.
Click on A5 and type “Roll No.”.
Click on B5 and type “English”.
Click on C5 and type “Urdu”.
Click on D5 and type “Maths”.
Click on E5 and type “Science”.
● Click on F5 and type “S. Studies”.
● Click on G5 and type “Islamiat”.
● Click on H5 and type “Comp. Edu.”.
● Click on I5 and type “Total Marks”.
● Click on J5 and type “Marks Obtained”.
● Type data in the sheet under the above headings, as shown in Figure 3.25.
● Click on K5 and type “% age”.
● Click on J6 and type “= SUM(B6:H6)”.
● Click on K6 and type “= (J6/700) * 100”.

Figure 3.25 shows a monthly result sheet.

Saving a Spreadsheet

The following steps are used to save a Spreadsheet.

● Click save button from the Quick Launch Toolbar.
   If user is saving the file for the first time, Save As Dialog box will appear, as shown in the Figure 3.26.
● Select the file location where to save the file.
Figure 3.26 Save As Dialog Box

- Type the name of the spreadsheet name such as Monthly Report.
- Click Save button to save the file with the desired name at the specified location.

3.2 Formatting Worksheet Elements

Changing the appearance of a cell's content is known as formatting. Formatting data makes the work more beautiful and more readable.

3.2.1 Select a Cell and Range of Cells to Apply Formatting

Selecting a Cell

To select a single cell:

- Click on the cell to select it. OR
- Move the cursor over to the desired cell by using the navigation keys.

In Figure 3.27 a single Cell C3 is selected.
**Selecting a Range of Cells**

**To Select Adjacent Cells:**
- Click the first cell.
- Hold down the **Shift** Key and click the last cell. OR
- Hold down the left mouse button on the first cell and drag the mouse to the last cell.

In Figure 3.28 range of Cells from B3 to E10 is selected.

**To Select Non-adjacent Cells:**
- Click the first cell.
- Hold down the **Ctrl** Key and click multiple cells to select.

In Figure 3.29, non-adjacent cells are selected.

After selecting a cell or range of cells, the user can apply any formatting commands.

**Do you know?**

Comparer is a temporary storage place in Computer memory. It is used temporarily for data that is being copied or moved.

**Copy – Paste and Cut – Paste**

The Copy – Paste option is used to take the duplicate of the selected cell contents by copying them and pasting them where required.
This option does not remove the text from the source location.

The Cut – Paste or Move option is used to move text from one place (source) to another place (destination). When users Cut or Copy text, it gets placed on the clipboard.

**Do you know?**

The copied cell will stay selected until you perform your next task, or you can double-click the cell to deselect it.

**To Copy and Paste:**

- Select the cell or cells to copy.
- Click the Copy command in the Clipboard group on the Home tab. The border of the selected cells will change appearance, as shown in Figure 3.30
- Select the cell or cells where to paste the contents.
- Click the Paste command in the Clipboard group on the Home tab. The copied contents will now appear in the new cells, as shown in Figure 3.31
- To select more than one neighboring cells, left-click one of the cells, drag the cursor until all the cells are selected, and release the mouse button.

![Figure 3.30 Copy](image)

![Figure 3.31 Paste](image)
Do you know?

You can use the following shortcut keys for Copy, Cut and Paste.

CTRL + C = COPY  
CTRL + X = CUT  
CTRL + V = PASTE

To Cut and Paste:

- Select the cell or cells to move.
- Click the Cut command in the Clipboard group on the Home tab. The border of the selected cells will change appearance, as shown in Figure 3.32
- Select the cell or cells to paste the contents.
- Click the Paste command in the Clipboard group on the Home tab. The cut contents will be removed from the original cells and now appear in the new cells, as shown in Figure 3.33

Figure 3.32 Cut  
Figure 3.33 Paste

Formatting Text

Text formatting includes formatting the font size, style, and colour; and using the Bold, Italic, Underline, and aligning the text. User can format a single cell or range
of cells. Figure 3.34 shows formatting tools.

**Font**

Font is the typeface of text and it is a set of characters used in typing of text in a particular style. Excel provides many different fonts from which user can choose.

**To Change Font:**

- Select cells to change the Font. For example G3 to J3 as in Figure 3.34
- Choose the **Home tab** as shown in Figure 3.34
- Click the down arrow next to the **Font box**. A list of fonts appears.
- Find and click the required font from the list. For example **Arial Black** as shown in Figure 3.34

**Do you know?**

As you scroll down the list of fonts, Excel provides a preview of the font in the cell you selected.

*Figure 3.34 Changing Font*
To Change Font Size:
- Select cell or cells to change the font size.
- Choose the **Home tab**.
- Click the down arrow next to the **Font Size box**. A list of font sizes appears.
- Click on the required size.

Figure 3.35 shows how to change the font size.

![Figure 3.35 Changing Font Size](image)

**Do you know?**

The size of a font is measured in points. There are 72 points to an inch. If font size is increased, the row height is automatically increased.

**Font Style**

There are four Font style available **Bold**, **Italic**, **Underline** and regular.

**To Change the Font Style:**
- Select cell or cells to change the style.
- Choose the **Home tab**.

![Figure 3.36 Changing Font Style](image)
• Click the required Font Style (Bold, Italic or Underline). For example, **Bold button** as shown in Figure 3.36

**To Change Font Colour:**
Select cell or cells to change the colour.

• Choose the **Home tab**.
• Click the down arrow next to the **Font Colour button**.
• Click on the required colour.

Figure 3.37 shows how to change the colour.
To Change Cell Alignment:

There are six types of alignments as shown in Figure 3.38

To Align:

Select cell or cells to align.

- Choose the **Home tab**.
- Click on the required alignment option in the Alignment group.
  
  For example, the Center button in the Alignment group as shown in Figure 3.39
  
  Excel centers each cell’s content.
Do you know?

When you type text into a cell, by default your entry aligns with the left side of the cell. When you type numbers into a cell, by default your entry aligns with the right side of the cell. You can change the cell alignment.

3.2.2 Applying Borders and Background Colour to a Cell / Range of Cells Borders

Borders are outlines around the cell or cells. User can use borders to make entries in worksheet stand out.

To Apply Borders:

- Select cell or cells to apply borders.
- Choose the Home tab.

![Figure 3.40 Applying Borders to the Selected Cells](image)
Click the down arrow next to the **Borders button**, a menu appears.
Click the required border option.
Excel applies the selected border to the selected cells, as shown in Figure 3.40

**Background Colour**

To Add Background Colour:
- Select cell or cells to add background colour.
- Choose the **Home tab**.
- Click the down arrow next to the **Fill Colour button**.

![Sample Worksheet](image)

*Figure 3.41 Changing Background Colour*

Click on the required colour, for example Orange. Excel applies an Orange background colour in the selected cells as shown in Figure 3.41
3.2.3 Inserting New Rows / Columns

User can insert new rows and columns as required.

To Insert a Column:

- Click on the column before which a new column is required to be inserted. For example, Column A in Figure 3.42
- Click the down arrow next to Insert in the Cells group. A menu appears as shown in Figure 3.43

![Figure 3.42 Selecting a Column](image1)

![Figure 3.43 Insert Sheet Columns Menu](image2)

- Click Insert Sheet Columns. Excel inserts a new column as shown in Figure 3.44
- Click anywhere on the worksheet to remove your selection.

![Figure 3.44 Inserting of a New Column](image3)
To Insert Row:
- Click on the row above which a new row is required to be inserted.
- Click the down arrow next to Insert in the Cells group. A menu appears as shown in Figure 3.45
- Click Insert Sheet Rows. Excel inserts a new row as shown in Figure 3.46

![Insert Sheet Rows Menu](image1)
![Inserting of a New Row](image2)

### 3.3 Inserting Charts

Charts are the graphical representation of data entered in a worksheet. Charts are helpful in showing the comparison between different categories. Different types of charts are used for different purposes. Excel offers many types of charts including Column, Line, Pie, Bar, Area, Scatter and more as shown in Figure 3.47

![Different Types of Charts](image3)
**Using Chart Wizard to Insert a Chart**

**To Insert a Chart:**
- Select the **cells** that contain the data to use in the chart.
- Click the **Insert tab** on the Ribbon.
- Click the type of **Chart** to insert.

*Figure 3.48(a)*

**To Insert Column Chart**

Select cells in the sheet as data for column chart. For example A3 to D8 as shown in Figure 3.48(a).

- Choose the **Insert tab**.

*Figure 3.48(b)*

- Click the **Column button** in the **Charts**. A list of column chart sub-types appears.
- Click the required chart sub-type. For example, Clustered Column charts sub-type as shown in Figure 3.48(b).
- Excel inserts a Clustered Column chart as shown in Figure 3.49

*Figure 3.49 Inserting Column Chart*
To Insert Line Chart

- User can also change the chart type from a column chart to a line chart.
- Click the chart to change chart. The Chart tools become available.
- Choose the Design tab.

![Figure 3.50(a)](image)

- Click Change Chart Type in the Type group. The Chart Type dialog box appears as shown in Figure 3.50(a).
- Click Line.
- Click Line with Markers sub-type.
- Click OK. Excel changes chart type to Line chart as shown in Figure 3.50(b).
To Insert Pie Chart

Pie charts or circle graphs are used to show percentages. The circle of pie charts represents 100%. The circle is sub-divided into slices representing data values. The size of each slice shows what part of the 100% it represents.

- Select the cells to include as data for Pie chart. For example the cells A2 to D5 as shown in the Figure 3.51
- Click the Insert menu.
- Click Pie from the Charts.
- Click the down arrow and select the first Pie chart sub-type
- A Pie chart is inserted as shown in Figure 3.51

Figure 3.51 Inserting Pie Chart
SUMMARY

Spreadsheets in Excel

- A spreadsheet is a computer application which is used to display data in multiple cells usually in a two-dimensional matrix or grid consisting of rows and columns.
- Spreadsheets are used in different fields for variety of purposes like accounting, budgeting, charting / graphing, financial analysis and scientific applications, etc.
- Excel is one of the popular and commonly used spreadsheet software.
- Excel screen is in the form of a rectangular table or grid of rows and columns. The horizontal rows are identified by numbers (1, 2, 3, …) and the vertical columns with alphabet (A, B, C or AA, AB, etc).
- A workbook is a file created by Excel spreadsheet application. Excel workbooks are actually sets of spreadsheet 'pages', each of which can include separate data.
- Worksheet also known as a spreadsheet is a single page in workbook.
- The Office Button is at the top left of the Excel window.
- Next to the Microsoft Office Button is the Quick Access Toolbar. The Quick Access Toolbar gives access to commands frequently used.
- Next to the Quick Access Toolbar is the Title bar. On the Title bar, Microsoft Excel displays the name of the workbook currently used.
- Formula bar displays the contents of the active cell and the formulae as user types them in an active cell.
- Name Box displays the reference of the active cell.
- The document (worksheet) window contains an Excel workbook that consists of a number of worksheets. A worksheet is a document window where user can enter data and modify it.
Sheet tabs are used to access different worksheets in a workbook.

Rows are arranged horizontally in a worksheet. They are identified by numbers in the row header (i.e. 1, 2, 3, 4, ...).

Columns in a worksheet are arranged vertically. They are identified by alphabet in the column header from A to Z, AA, AB, AC to XFD.

The intersection of row and column in a worksheet is called cell. Cell is the basic unit in the worksheet where user can enter data, function or formula.

The active cell is the cell which is currently selected.

Cell Address or Cell Reference identifies the location of a cell or group of cells in a worksheet. It consists of the column letter and row number that intersect at the cell's location.

Selecting more than one cell is known as a cell range.

Data manipulation involves entering, editing and formatting data.

Editing data means doing any changes in it.

Auto filling is the use of the fill-handle to copy data and sequences across a range of cells. The fill-handle is at the right corner of each cell.

Formula is an equation that performs a calculation using values in the worksheet. A formula always begins with an equals sign followed by either values or cell references and an operator.

Functions are pre-defined or built-in formulae.

The SUM function adds all the numbers that user specifies as arguments.

The PRODUCT function multiplies all the numbers given as arguments and returns the product.

AVERAGE function returns the average (arithmetic mean) of the arguments.

POWER function returns the result of a number raised to a power.

SQRT function calculates the square root of a given number.
MAX function returns the largest value from a supplied set of numerical values.

MIN function returns the smallest value from a supplied set of numerical values.

Changing the appearance of a cell's content is known as formatting. Formatting data makes the work more beautiful and more readable.

The Copy-Paste option is used to take the duplicate of the selected cell contents by copying them and pasting them where required. This option does not remove the text from the source location.

The Cut-Paste or Move option is used to move text from one place (source) to another place (destination).

When users Cut or Copy text, it gets placed on the clipboard.

Text formatting includes formatting the font size, style, and colour and using the Bold, Italic, Underline, and Aligning the text.

Font is the typeface of text and it is a set of characters used in typing of text in a particular style.

Borders are outlines around the cell or cells. User can use borders to make entries in worksheet stand out.

Charts are the graphical representation of data entered in a worksheet. Charts are helpful in showing the comparison between different categories.

Excel offers many types of charts including Column, Line, Pie, Bar, Area, Scatter and many more.

Pie charts or circle graphs are used to show percentages.
Q1. **Tick the correct choice for the following questions.**

i. Where is Microsoft Office Button located in Excel window?
   a. Top Left
   b. Top Right
   c. Bottom Left
   d. Bottom Right

ii. How many command Tabs are there in Excel 2007 window by default?
   a. Five
   b. Six
   c. Seven
   d. Eight

iii. In Excel, which of the following is the intersection of a row and a column?
   a. Table
   b. Form
   c. Cell
   d. Formula

iv. Which of the following is Spreadsheet Software?
   a. Word
   b. PowerPoint
   c. Access
   d. Excel

v. Which of the following bars gives access to the frequently used commands in Excel?
   a. Quick Access Toolbar
   b. Formatting Toolbar
   c. Status bar
   d. Scroll bar
vi. By default, how many sheet tabs are available in Excel workbook?
   a. Two
   b. Three
   c. Four
   d. Five

vii. ____________ are arranged vertically in an Excel worksheet.
   a. Rows
   b. Columns
   c. Cells
   d. Active Cells

viii. What is a currently selected cell in a spreadsheet called?
   a. First Cell
   b. Main Cell
   c. Active Cell
   d. Any Cell

ix. ____________ consists of the column letter and row number that intersect at the cell's location.
   a. Cell address
   b. Cell location
   c. Selected cell
   d. Active cell

x. What is the purpose of Cut – Paste command?
   a. Copies the contents from one cell to another location
   b. Moves the contents from one cell to another location
   c. Deletes the content without copying
   d. Have no effect on cell contents

Q2. Fill in the blanks.

i. ____________ is a computer application which displays data in multiple cells usually in a two-dimensional matrix or grid consisting of rows and columns.
ii. _____________ is a file created by Excel spreadsheet application.
iii. _____________ is a single page in workbook.
iv. Next to the Microsoft Office Button is _____________.
v. _____________ bar displays the contents of the active cell and the formulae as user types them in an active cell.
vi. _____________ Box displays the reference of the active cell.
vii. Selecting more than one cell is known as _____________.
viii. _____________ is the use of the fill-handle to copy data and sequences across a range of cells.
ix. _____________ is an equation that performs a calculation using values in the worksheet.
x. _____________ are pre-defined or built-in formulae.
xii. When users Cut or Copy text, it gets placed on the _____________.
xiv. _____________ are the graphical representation of data entered in a worksheet.

Q3. Match Column A with Column B.

<table>
<thead>
<tr>
<th>Column A</th>
<th>Column B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spreadsheet</td>
<td>Currently used cell</td>
</tr>
<tr>
<td>Ribbon</td>
<td>Cell reference</td>
</tr>
<tr>
<td>Active cell</td>
<td>Fill handle</td>
</tr>
<tr>
<td>Name box</td>
<td>Excel</td>
</tr>
<tr>
<td>Auto-filling</td>
<td>Command Tabs</td>
</tr>
<tr>
<td>Predefined formula</td>
<td>Function</td>
</tr>
</tbody>
</table>
Q4. **Give brief answers to the following questions.**

i. Define the following terms:
   - Spreadsheet, Workbook, Worksheet, Cell, Cell address,
   - Cell Reference, Formula, Function

ii. Give few purposes of Spreadsheet.

iii. Name any five components of Excel window.

iv. What is cell range? Give one example.

v. What is Auto-filling data feature in Excel? Give one example.

vi. How formula is used in Excel sheet? Give one example.

vii. Name different parts of function with the help of an example.

viii. What is the difference between Copy-Paste and Cut-Paste?

ix. What is a chart? Name any three types of charts used in Excel.

Q5. **Give detailed answers to the following questions.**

i. Explain different parts / components of Excel window.

ii. Explain basic elements of a worksheet.

iii. What is purpose of the following functions? Give one example of each.
   - SUM, PRODUCT, AVERAGE, POWER, SQRT, MAX, MIN

iv. What is text formatting? Give procedure to change font and font size in Excel.

v. What is a border? Give procedure to apply a border to a selected range in Excel.

vi. Give procedure to insert new rows and columns in Excel.

vii. Write down the steps to create a Bar chart in Excel.

viii. Write down the steps to create a Pie chart in Excel.
Activity 1: Create the following sheet in Excel.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Length</td>
<td>Width</td>
<td>Area</td>
</tr>
<tr>
<td>2</td>
<td>12</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14</td>
<td>23</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>16</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>17</td>
<td>16</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>15</td>
<td>21</td>
<td></td>
</tr>
</tbody>
</table>

Enter the formula to calculate the area of rectangle in cell C2 and copy the formula from Cells C3 to C6 by dragging the fill-handle downwards.

*Hint:* Area of Rectangle = Length x Width

Activity 2: Create the following worksheet, centralize the data and draw the line graph for the given data.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Overs</td>
<td>Team 1</td>
<td>Team 2</td>
</tr>
<tr>
<td>2</td>
<td>5</td>
<td>55</td>
<td>67</td>
</tr>
<tr>
<td>3</td>
<td>10</td>
<td>112</td>
<td>100</td>
</tr>
<tr>
<td>4</td>
<td>15</td>
<td>165</td>
<td>145</td>
</tr>
<tr>
<td>5</td>
<td>20</td>
<td>190</td>
<td>191</td>
</tr>
</tbody>
</table>

Activity 3: Create a worksheet to enter the following data for your 10 friends.

<table>
<thead>
<tr>
<th>Names</th>
<th>Age</th>
<th>Weight</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Enter data in the worksheet.
- Apply SUM function to find the total weight and total age of your friends.
- Apply the appropriate function to find the average weight and average age.
- Apply the MAX function to find the maximum weight and maximum age.
e. Apply the MIN function to find the minimum weight and minimum age.

f. Create bar chart to show the weights and ages.

**Activity 4:** Create the following spreadsheet which shows the destination of people who travelled in Blue-lines Taxis during one week.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Monday</td>
<td>5</td>
<td>4</td>
<td>7</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Tuesday</td>
<td>8</td>
<td>8</td>
<td>3</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Wednesday</td>
<td>2</td>
<td>6</td>
<td>7</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Thursday</td>
<td>3</td>
<td>9</td>
<td>8</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Friday</td>
<td>6</td>
<td>4</td>
<td>7</td>
<td>7</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Saturday</td>
<td>7</td>
<td>7</td>
<td>6</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Sunday</td>
<td>0</td>
<td>6</td>
<td>9</td>
<td>8</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Total</td>
<td>31</td>
<td>44</td>
<td>47</td>
<td>38</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Percentage</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

a. Give formula to find the total in Cell F2.
b. Select the range of cells from F3 to F9 and copy the formula from cell F2 in it.
c. Give a formula in B10 to calculate the percentage and copy it from cells C10 to F10.
d. Create a labeled pie chart showing the number of people travelling to the station that week.

**Activity 5:** The City Government is developing a website to inform the general public about the weather. A spreadsheet was produced to show some of the statistical data.
<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
<th>K</th>
<th>L</th>
<th>M</th>
<th>N</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Jan</td>
<td>Feb</td>
<td>Mar</td>
<td>Apr</td>
<td>May</td>
<td>Jun</td>
<td>Jul</td>
<td>Aug</td>
<td>Sep</td>
<td>Oct</td>
<td>Nov</td>
<td>Dec</td>
<td>Averages</td>
</tr>
<tr>
<td>2</td>
<td>Monthly Rainfall (mm)</td>
<td>130</td>
<td>210</td>
<td>340</td>
<td>350</td>
<td>220</td>
<td>170</td>
<td>100</td>
<td>30</td>
<td>26</td>
<td>20</td>
<td>10</td>
<td>50</td>
</tr>
<tr>
<td>3</td>
<td>Hours Sunshine (per day)</td>
<td>7</td>
<td>6</td>
<td>6</td>
<td>6</td>
<td>9</td>
<td>10</td>
<td>10</td>
<td>6</td>
<td>9</td>
<td>9</td>
<td>10</td>
<td>8</td>
</tr>
<tr>
<td>4</td>
<td>Minimum Temperature (°C)</td>
<td>3</td>
<td>8</td>
<td>12</td>
<td>18</td>
<td>24</td>
<td>30</td>
<td>28</td>
<td>25</td>
<td>23</td>
<td>20</td>
<td>15</td>
<td>10</td>
</tr>
<tr>
<td>5</td>
<td>Maximum Temperature (°C)</td>
<td>12</td>
<td>18</td>
<td>23</td>
<td>29</td>
<td>38</td>
<td>48</td>
<td>46</td>
<td>41</td>
<td>40</td>
<td>35</td>
<td>30</td>
<td>20</td>
</tr>
</tbody>
</table>

a. What formula is used in N2 to show the average (mean) rainfall?
b. Insert a line chart to show Hours Sunshine and Monthly Rainfall for the whole year.

**Activity 6:** Create the following spreadsheet to show the result of six students.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Name</td>
<td>Total Marks</td>
<td>Obtained Marks</td>
</tr>
<tr>
<td>2</td>
<td>Ali</td>
<td>800</td>
<td>650</td>
</tr>
<tr>
<td>3</td>
<td>Mona</td>
<td>800</td>
<td>700</td>
</tr>
<tr>
<td>4</td>
<td>Hassan</td>
<td>800</td>
<td>456</td>
</tr>
<tr>
<td>5</td>
<td>Fatima</td>
<td>800</td>
<td>544</td>
</tr>
<tr>
<td>6</td>
<td>Waheed</td>
<td>800</td>
<td>329</td>
</tr>
</tbody>
</table>

Apply the following formatting on the sheet:

a. Make Row 1 as bold and centralize it.
b. Change font size of Column 1 and Row 1 to 18 points.
c. Change the font of the numeric data to Arial black.
d. Select the range from B2 to D6 and apply a border.
e. Change to background colour of Row1 and Column 1 to yellow.
After completing this unit, students will be able to:

- make a clear statement of the problem.
- extract the following from the problem statement
  - What is given - the input
  - What is required - the output
  - The processing requirements
- define a flowchart.
- identify the standard flowchart symbols
  - Start / terminal symbol
  - Processing symbol
  - Decision symbol
  - Input / Output symbol
  - Flow lines
- draw a flowchart to solve problems, like
  - to make tea
  - to make an omelet
  - to find the sum and average of five given numbers
  - to find the product of five given numbers
  - to display the larger one out of the two given unequal numbers
  - to find the area of a rectangular region with given length and width
  - to find the area of a circular region with given radius
Unit Introduction

Problem solving techniques are helpful in solving problems. Problem solving technique starts from stating the problem and extracting information like input, processes (to solve problem) and defining output.

In problem solving, flowcharting is a tool to describe the flow of the program. Flowcharts are helpful in understanding the logic of the program and the sequence of steps involved in reaching the output. Such problem solving techniques will be discussed in this unit.

4.1 Problem Solving

In our daily life we face different problems at home or at work which may be large and complex. We need to solve these problems in a simple and efficient way. Before discussing about problem solving, we must understand what a problem is?

A problem is an obstacle, hurdle, difficulty or challenge, or any situation that needs to be removed or solved. The solution of a problem is recognized as a solution or contribution toward a known purpose or goal. Problem is a state of difficulty that needs to be resolved.

Problem solving is a process to solve different types of problems. The goal of problem solving is to get the desired result in a short and perfect manner. In Figure 4.1, a student is thinking to solve a problem.

4.1.1 Problem Statement

A problem statement is a concise description of the problem to be solved. It is a good idea to state a problem before trying to solve it.
### 4.2.1 Flowchart

A flowchart is a type of diagram that represents a process, showing the steps as symbols of various kinds, and their order by connecting them with arrows. This diagrammatic representation can give a step-by-step solution to a given problem. Flowchart helps in finding the solution of a problem and facilitate in showing the input, process and output of the problem.

The following are some benefits of flowcharts.
- It helps in understanding the logic of the problem solving processes.
- It gives the pictorial representation of the processes involved in the problem solution.
- It shows the flow processes in a sequential manner.

### 4.2.2 Standard Flowchart Symbols

Flowcharting use standardized sets of symbols. Flowchart Symbols with their description and examples are given in the following table.

<table>
<thead>
<tr>
<th>Description</th>
<th>Symbol</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start / End Symbol</td>
<td><img src="image" alt="Start" /> <img src="image" alt="End" /></td>
<td></td>
</tr>
<tr>
<td>An oval shape symbol that represents the Start or End of a flowchart.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Input / Output Symbol</td>
<td><img src="image" alt="Input A, B" /> <img src="image" alt="Read Name Age, Class" /></td>
<td></td>
</tr>
<tr>
<td>The input / output in a flowchart is represented by a parallelogram shape.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Processing Symbol
Rectangle shape symbol is used to represent the process or action taken.

<table>
<thead>
<tr>
<th>![Symbol]</th>
<th>Sum = A + B</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Symbol]</td>
<td>X = 15</td>
</tr>
</tbody>
</table>

### Flow Lines
Arrow head with line is used to show the flow of any process in a flowchart. These symbols show the flow of data, information or process in the flowchart.

### Decision Symbol
Diamond symbol is used to show decision process in a flowchart.

<table>
<thead>
<tr>
<th>![Symbol]</th>
<th>![Symbol]</th>
</tr>
</thead>
<tbody>
<tr>
<td>X &gt; 15 Yes</td>
<td>C &lt; 10 Yes</td>
</tr>
<tr>
<td></td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
</tbody>
</table>
Guidelines for Flowcharting

Following guidelines should be followed while drawing a flowchart:

- Flowchart should be clear, neat and easy to follow.
- Flow of flowchart is either from left to right or from top to bottom.
- Only one flow line should enter and come out of the process symbol.

- Only one flow line should enter a decision symbol, but two flow lines could come out, one for each possible answer, should leave the decision symbol.

- Only one flow line is used in Start / End symbol.

- Avoid the intersection of flow lines to make it more effective.

4.2.3 Some Examples of Flowcharts

Some sample flowcharts to solve some simple problems are given as follows:
Flowchart to Make Tea

1. Start
2. Pour water
3. Boil water
4. Add tea leaves in the Kettle
5. Let the tea leaves to boil
6. Pour tea into cup
7. Pour milk into cup
8. Is Sugar needed?
   - Y: Add sugar
   - N: Stir
9. Tea is ready
10. Stop
Flowchart to Make an Omelet

Start

Add ingredients; eggs, onion salt and pepper

Beat the mixture

Warm oil in the pan

Pour mixture in the pan

Cook

Is omelet cooked?

Y

Take out in plate

N

Cook more

Serve

Stop
Flowchart to Find the Sum and Average of Five Given Numbers

1. Start
2. Input five numbers
3. Add five numbers
4. Divide the sum by 5 to get average of numbers
5. Display sum
6. Display Average
7. Stop

Flowchart to Find the Product of Five Given Numbers

1. Start
2. Input five numbers
3. Multiply the numbers to get the product
4. Display Product
5. Stop
Flowchart to Display the Larger One out of the Two Given Unequal Numbers

1. Start
2. Input two numbers A, B
3. IF A > B
   - Y: Display A
   - N: Display B
4. Stop

Flowchart to Find the Area of a Rectangular Region with Given Length and Width

1. Start
2. Input length and width
3. Area of the Rectangular Region = Length * Width
4. Display Area
5. Stop
Flowchart to Find the Area of a Circular Region with Given Radius

1. Start
2. Input radius of circle, \( r \)
3. Area of the Circular Region \( = 3.14 \times r \times r \)
4. Display Area
5. Stop

SUMMARY

Problem Solving

- A problem is an obstacle, hurdle, difficulty or challenge, or any situation that needs to be removed or solved.
- Problem solving is a process to solve different types of problems. The goal of problem solving is to get the desired result in a short and perfect manner.
- A problem statement is a concise description of the problem to be solved. It is a good idea to state a problem before trying to solve it.
- A problem statement has three elements as 'What is given – the Input', 'The Processing requirements', and 'What is required – the Output'.
- Input is such element of the problem statement that we give to the computer as raw material to solve the problem.
The Processing requirements involve performing actions or operations on input data to achieve the desired goals and find the solution to the problem.

Output is the result which is obtained by processing the input data. It is also called the solution.

Flowcharting is a process of pictorial illustration for solving a problem.

A flowchart is a type of diagram that represents a process, showing the steps as symbols of various kinds, and their order by connecting them with arrows.

Flowcharting use standardized sets of symbols.

An oval shape symbol is used to represent the Start or End of a flowchart.

The input/output in a flowchart is represented by a parallelogram shape.

Rectangle shape symbol is used to represent the process or action taken.

Diamond symbol is used to show decision process in a flowchart.

Arrow head with line is used to show the flow of any process in a flowchart.

Q1. **Tick the correct choice for the following questions.**

i. How many elements a problem has?

   a. 1
   b. 2
   c. 3
   d. 4
ii. What is the solution to a problem called?
   a. Problem Solving
   b. Problem Statement
   c. Identifying Problem
   d. Ignoring Problem

iii. A _______ is an obstacle, hurdle, difficulty or challenge, or any situation that needs to be removed or solved.
    a. Answer
    b. Solution
    c. Situation
    d. Problem

iv. What is the name of the problem statement element that we give to the computer as raw material to solve the problem?
   a. Input
   b. Output
   c. Process
   d. Ideas

v. ____________ is the result which is obtained by processing the input data.
   a. Input
   b. Output
   c. Process
   d. Algorithm

vi. Which symbol is used to show decision process in the flowchart?
    a. Oval
    b. Rectangle
    c. Diamond
    d. Parallelogram
vii. In flowchart which symbol uses only one flow line?
   a. Terminal
   b. Processing
   c. Decision
   d. Input

viii. Which symbol is used to represent a process in the flowchart?
   a. Oval
   b. Rectangle
   c. Diamond
   d. Parallelogram

Q2. **Fill in the blanks.**
   i. ________________ techniques are helpful in solving problems.
   ii. A _________________ is a concise description of the problem to be solved.
   iii. _________________ involves performing actions or operations on input data to achieve the desired goals and find the solution to the problem.
   iv. _________________ is a process of pictorial illustration for solving a problem.
   v. The input / output in a flowchart is represented by a ___________ shape.

Q3. **Match Column A with Column B.**

<table>
<thead>
<tr>
<th>Column A</th>
<th>Column B</th>
</tr>
</thead>
<tbody>
<tr>
<td>A problem</td>
<td>What is given</td>
</tr>
<tr>
<td>A problem statement</td>
<td>Diagram to represent a process</td>
</tr>
<tr>
<td>The Input</td>
<td>What is required</td>
</tr>
<tr>
<td>Flowchart</td>
<td>A hurdle</td>
</tr>
<tr>
<td>The Output</td>
<td>A concise description of the problem</td>
</tr>
</tbody>
</table>
Q4. Give brief answers to the following questions.
   i. What are the key features of a problem statement?
   ii. What is flowchart?
   iii. What are the uses of flowchart?
   iv. What are the advantages of drawing flowchart?
   v. What is the use of decision symbol?

Q5. Give detailed answers to the following questions.
   i. Explain the elements of a problem statement.
   ii. What is flowcharting? How flowcharts help in problem solving?
   iii. Explain different symbols used to draw flowcharts with examples.

LAB ACTIVITIES

Lab Activity

Draw flowcharts for the following problems:
   i. To find the smallest of the two given unequal numbers.
   ii. To find the square of a given number.
   iii. To convert the Fahrenheit temperature into Celsius temperature.
   iv. To convert the Celsius temperature into Fahrenheit temperature.
   v. To find the area of a square region with given side.
After completing this unit, students will be able to:

- define
  - Program
  - Programming Language
- differentiate between
  - Constants and Variables
  - Syntax and Logical Errors
- recognize an arithmetic expression.
- know
  - Arithmetic operators and their order of precedence
  - Assignment operator
  - Relational operators
- get familiar with the use of
  - Basic commands
  - Print statement
  - Input statement
  - Read and data statements
  - IF-THEN-ELSE statement
- assign a variable to an arithmetic expression.
- write programs to solve problems, e.g.
  - to find the sum and average of five given numbers
  - to find the product of five given numbers
  - to display the larger one out of the two given unequal numbers
  - to find the area of a rectangular region with given length and width
  - to find the area of a circular region with given radius
  - to convert Celsius to Fahrenheit and vice versa, using appropriate formula


Unit Introduction

A computer is unable to do anything on its own. It requires instructions to do something. These instructions enable the computer to accomplish tasks.

A set of instructions is called a program. Programming languages are used to develop programs. In this unit, students will learn about basics of computer programming and to write simple programs.

5.1 Introduction to Programming

Programming is a technique to develop programs. Different programming languages are used to write programs. These programs tell the computer what to do and how to do.

In simple words computer programming is all about developing, implementing and maintaining all the programs. Individuals who perform the task of writing these programs are called Computer Programmers.

5.1.1 Program and Programming Language

Program

A computer program is a sequence of instructions given to the computer to perform a specific task. Programs are written in languages called computer languages or programming languages. Computer can only do exactly what the program tells the computer to do. Computer follows the instructions written in the program to perform a particular task. A computer program is stored as a file on the computer's storage medium, like hard disk. Few examples of programs are:

- A program to find the average marks of a student in the final exam.
- A program to find area of a circle for given radius.
- A program to solve a quadratic equation.
- A program to control financial matters of a company.
- A program to manage items in a grocery shop.
Programming Language

Natural languages, like Urdu, English, Arabic and French, etc. are the means of communication among people to share their ideas and views. In the same way, programming languages are the means of communication between users and the computer. Users as well as computers understand these languages.

A programming language is a language designed to develop programs or instructions to communicate with the computer to solve various problems. There are different programming languages having their own set of rules and regulations that the computer programmers follow to write computer programs. Most of these languages use English words as statements and commands to create programs. Some examples of programming languages are FORTRAN, COBOL, C, C++, C#, Java and BASIC, etc.

5.1.2 Constants and Variables

Constants and variables are the two important terminologies used in programming.

Constants

Constants are the quantities whose values cannot be changed during program execution or running. These are the named spaces in the computer's memory. Constants are classified as string constants and numeric constants.

- **String Constants**: These are sequence of alphabetic or alphanumerical characters enclosed in double quotation marks. For example “Male”, “Married”, “Haris”, “Pakistan” and “H. No. 107”, etc.
- **Numeric Constants**: These are the numbers, for example 117, 20.50, -50 etc.

Variables

It is a named space in the computer's memory whose value can be changed during the execution of a program. Variables give meaningful names to constants. They are also used to store data and results during program execution. There are two types of variables.
• **Numeric Variables:** These are used to store numeric constants such as 10, 134, 12.34 and -312, etc. For example:
  \[ X = 25 \quad (X \text{ is a variable and } 25 \text{ is a numeric constant}) \]
  \[ \text{NUM} = 35.6 \quad (\text{NUM is a variable and } 35.6 \text{ is a numeric constant}) \]

• **String Variables:** String variables are used to store sequence of characters or strings enclosed in double quotations. String variables can store string constants. For examples:
  \[ \text{NAME} = “Ahmad” \]
  \[ \text{COUNTRY} = “Pakistan” \]
  In BASIC programming language $ (Dollar sign) is used as a last character with string variable. For example:
  \[ \text{COUNTRY$} = “Pakistan” \]
  \[ \text{CAPITAL$} = “Islamabad” \]
  In programming languages, like BASIC, certain rules are followed to declare/define a variable name. These are:
  • Alphabet and numbers can be used for variables.
  • The first character of the variable should be an alphabet.
  • No special symbol is allowed except Underscore (_).
  • Underscore (_) cannot be used as a first or last character.

5.1.3 **Syntax and Logical Errors**

In a program, the occurrence of incorrect or unexpected result is called an error. Errors occur due to some mistake in performing operations in a program. There are two common types of errors in programming.

• Syntax Error
• Logical Error

**Do you know?**

The syntax of a programming language is the set of rules that define the combination of symbols used by that language.
**Syntax Error**

A syntax error occurs when the instructions written in a program do not follow the rules of the programming language. Syntax errors are easy to find and correct because the computer finds them for the user.

Examples: PRNT instead of PRINT

5 = X instead of X = 5

**Logical Error**

A logical error is an error resulting in wrong answer due to programmers own logical mistake. These errors occur due to wrong use of formulae or providing wrong value to a variable. If a programmer writes a statement that is logically incorrect, the computer will understand and execute it but the result will be wrong. For example, if a programmer accidentally multiplies two variables when he or she meant to divide them, the program will give an incorrect result, but no error message. Such errors cannot be detected by a computer therefore they are hard to find and correct.

Examples: SUM = X − Y instead of SUM = X + Y

AREA = Pie * R³ instead of AREA= Pie * R²

**5.1.4 Arithmetic Expression**

An expression is a combination of symbols and operators that represents a value. Every expression consists of at least one operand and can have one or more operators. Operands are values, whereas operators are symbols that represent particular actions. For example, in the expression

\[ X + 3 \]

X and 3 are operands, and + is an operator.

An expression which represents a numeric value is called an Arithmetic Expression. An Arithmetic Expression is evaluated by performing a sequence of arithmetic operations to obtain a numeric value.

Some examples of Arithmetic Expressions are as follows:

Exp 1 = (A+3)*(C+2)

Exp 2 = 2*X + 3*Y

Exp 3 = 2 * 3.14*R
Algebraic expression cannot be used directly in programming. It must be converted into computer understandable expression. Few examples are given in the following table:

<table>
<thead>
<tr>
<th>Algebraic Expression</th>
<th>BASIC Expression</th>
</tr>
</thead>
<tbody>
<tr>
<td>A = L * B</td>
<td>A = L * B</td>
</tr>
<tr>
<td>P = 2(L + B)</td>
<td>P = 2*(L + B)</td>
</tr>
<tr>
<td>I = (P \times T \times R)/100</td>
<td>I = (P * T * R)/100</td>
</tr>
<tr>
<td>V = 4/3 Pie R^3</td>
<td>V = 4/3 * Pie * R^3</td>
</tr>
</tbody>
</table>

### 5.1.5 Operators

Operators are symbols that indicate the type of operation to be performed on the data. There are three common types of operators which are given below:

- **Arithmetic Operators** (+, −, *, /, ^, MOD)
- **Assignment Operator** (=)
- **Relational Operators** (>, <, >=, <=, >=)

### Arithmetic Operators

Arithmetic Operators are used to perform mathematical calculations like addition, subtraction, division, multiplication and exponentiation. The following table gives the description of arithmetic operators with examples.

<table>
<thead>
<tr>
<th>Operator Symbol</th>
<th>Operation</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Addition</td>
<td>Gives the sum of values</td>
<td>A + B + C, X + 50, 67 + 45</td>
</tr>
<tr>
<td>−</td>
<td>Subtraction</td>
<td>Gives the difference of values</td>
<td>X – 56, A – C, 80 – 56</td>
</tr>
<tr>
<td>*</td>
<td>Multiplication</td>
<td>Gives the product of values</td>
<td>A * B, Y * 50, 45 * 60</td>
</tr>
<tr>
<td>/</td>
<td>Division</td>
<td>Gives the quotient</td>
<td>X / Y, B / 40, 125 / 25</td>
</tr>
<tr>
<td>^</td>
<td>Exponentiation</td>
<td>Raise the value to the power of an exponent</td>
<td>A ^ 10, 5 ^ 2, A ^ B</td>
</tr>
<tr>
<td>MOD</td>
<td>Modulus</td>
<td>Gives the remainder after division</td>
<td>35 MOD 6, X MOD Y</td>
</tr>
</tbody>
</table>
**Precedence of Arithmetic Operators**

Precedence is the priority that is followed while applying these operators. This becomes important when more than one kind of arithmetic operator appears within one expression.

The precedence of arithmetic operators is given in the following table:

<table>
<thead>
<tr>
<th>Priority Level</th>
<th>Operator</th>
<th>Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>First</td>
<td>Exponentiation Operator</td>
<td>(^)</td>
</tr>
<tr>
<td>Second</td>
<td>Multiplication or division</td>
<td>* OR /</td>
</tr>
<tr>
<td></td>
<td>Operator</td>
<td></td>
</tr>
<tr>
<td>Third</td>
<td>Mod Operator</td>
<td>MOD</td>
</tr>
<tr>
<td>Fourth</td>
<td>Addition or Subtraction Operator</td>
<td>+ OR -</td>
</tr>
</tbody>
</table>

Same priority operators are resolved from left to right.

In an expression the operations within parentheses () are resolved first. The usual order inside the parentheses is maintained as given in the above table. The following are few examples to show the precedence of arithmetic operators.

**Example 1:** Solve the expression, \(X + Y / 10\), where \(X = 30\) and \(Y = 50\)

**Solution:**

\[
\begin{align*}
X + Y / 10 & \quad (\text{Division will be resolved first}) \\
= 30 + 50 / 10 & \quad (\text{Addition will be resolved next}) \\
= 30 + 5 & \quad \\
= 35 & \quad \\
\end{align*}
\]

**Example 2:** Solve the expression, \((A + B) * B / 10\), where \(A = 20\) and \(B = 30\)

**Solution:**

\[
\begin{align*}
(A + B) * B / 10 & \quad (\text{The operation in the parenthesis will be resolved first}) \\
= (20 + 30) * 30 / 10 & \quad (\text{Multiplication will be resolved next}) \\
= 50 * 30 / 10 & \quad (\text{Division will be resolved in the end}) \\
= 1500 / 10 & \quad (\text{Division will be resolved in the end}) \\
= 150 & \quad \\
\end{align*}
\]
Assignment Operator

An operator which is used to assign a value to a variable is called Assignment Operator. In programming languages “Equal sign” (=) is used as an assignment operator.

Example 1: \[ A = 5 \]

In the above example, 5 is assigned to the variable A.

Example 2: \[ X = A + 2.54 \]

This expression instructs the computer to calculate \( A + 2.54 \) and assign the result to \( X \).

Relational Operators

Relational Operators are used to perform comparisons on two values. The result of comparison is either true (non zero) or false (zero). The following table gives the description of relational operators with examples:

<table>
<thead>
<tr>
<th>Operator Symbol</th>
<th>Operation</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>=</td>
<td>Equal to</td>
<td>Returns true if the two values are equal, and false if not.</td>
<td>( A = B )</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>Not Equal to</td>
<td>Returns true if the two values are not equal, and false if they are equal.</td>
<td>( 5 &lt;&gt; 7 )</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than</td>
<td>Returns true if the first number is greater than the second, and false if not.</td>
<td>( 15 &gt; 11 )</td>
</tr>
<tr>
<td>&lt;</td>
<td>Less than</td>
<td>Returns true if the first number is less than the second, and false if not.</td>
<td>( 7 &lt; 9 )</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Greater than or Equal to</td>
<td>Returns true if the first number is greater than or equal to the second, and false if not.</td>
<td>( (X+1) &gt;= 7 )</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Less than or Equal to</td>
<td>Returns true if the first number is less than or equal to the second, and false if not.</td>
<td>( Y &lt;= 5 )</td>
</tr>
</tbody>
</table>
5.2 Programming in BASIC

BASIC stands for Beginner’s All purpose Symbolic Instruction Code. BASIC was invented at Dartmouth College, USA in 1963 by John Kemeny and Thomas Kurtz. BASIC is easy to learn and understand. It is easy to write and run a program in BASIC language. BASIC was developed as an instructional tool to teach computer programming.

There are different versions of BASIC language available. In this unit, GWBASIC language will be used. Here are some important rules to write a program in GWBASIC language.

- Each instruction must be written in separate line.
- Each line will start with a unique line number like, 1,2,3,….. Normally we take line numbers as 10,20,30 ....
- The line number may be whole integer between 0 and 65000.
- Maximum length of a line is 255 characters.
- Two instructions can be written in a single line separated by “:” operator.

How to Run GWBASIC Program?

To run GWBASIC simply double click the GWBASIC icon. The following screen will appear as shown in Figure 5.1:

![Figure 5.1 GWBASIC Window](image-url)
Structure of a BASIC Program

A program in BASIC is written in the form of statements. These statements are written in the logical order to solve the problem. The rules to write these statements are:

- In BASIC each statement is started with a line number.
- Line numbers are positive integers starting from 0 to 65000.
- Each statement should be written on a separate line.
- Line numbers are executed in the ascending order.

5.2.1 BASIC Commands and Statements

In BASIC programming language, instructions are given to the computer using commands and statements.

Commands

Commands are key words which are used to issue instructions to the computer to perform specific tasks. Some important GWBASIC commands are discussed as follows:

CLS

CLS stands for Clear Screen. It is used to clear the contents of the screen.

Syntax  CLS

Figure 5.2 shows the application of CLS while Figure 5.3 shows the resulting screen after its application.
LIST

List command shows the list of all or part of a loaded program on the screen. **F1** key is used as a shortcut key for LIST command.

**Syntax:**  \[ \text{LIST} \text{[line number]}\text{[-line number]} \]  \ OR  \ **Press F1key**

**Examples:**
- **LIST**: Lists all lines in the program.
- **LIST-20**: Lists lines 1 through 20.
- **LIST 10-20**: Lists lines 10 through 20.
- **LIST 20-**: Lists lines 20 through the end of the program.

Figure 5.4 shows the application of LIST while Figure 5.5 shows the resulting screen after its application.
RUN

RUN command is used to execute (get result) of the program. F2 key is used as a shortcut key for RUN command.

Syntax: RUN OR Press F2 key

Example: RUN

The above command will execute the whole program as shown in Figure 5.6
LOAD

Load command is used to load (open) a file from any storage medium like Hard Disk into the main memory of the computer. **F3** key is used as a shortcut key for LOAD command.

**Syntax:**    LOAD ‘filename’     OR  Press F3 key

**Example:**    LOAD "PROG1"

The above command loads the program PROG1.bas into the memory of the computer. The loading of the program and its listing is shown in Figure 5.7.

![Figure 5.7 Application and Result of LOAD Command](image)

SAVE

SAVE command is used to save the program in the Hard Disk or any other storage media. **F4** key is used as a shortcut key for SAVE command.

**Syntax:**    SAVE filename     OR  Press F4 key

**Example:**    SAVE "MYPRG1"

The above command will save the program with the name MYPRG1.bas as shown in Figure 5.8.
Statements

Statements are the instructions for the computer program to perform an action. There are different types of statements that can be given in a computer program in order to direct the actions to solve any problem.

Each instruction in a GWBASIC program is called a statement. The following are some important GWBASIC Language statements:

PRINT Statement

The PRINT statement is used to display message or output to the screen. As shortcut “?” can be used for PRINT command.

Syntaxes of PRINT statement are:

**Syntax 1:** Line Number PRINT “Sequence of characters / String”

**Example:** 10 PRINT “I Love Pakistan”

The above statement will output a string message “I Love Pakistan” on the screen.

**Syntax 2:** Line Number PRINT “Variables / Constants”

**Example:** 10 PRINT X, Y, Z

The above statement will output values of variable X, Y and Z on the screen.

20 PRINT 205, -101

The above statement will output constant values 205 and -101 on the screen.
Syntax 3: Line Number PRINT “String”, Variables / Constants

Example: 10 PRINT “Sum of numbers = “, SUM

The above statement will output a string “Sum of numbers = “ with the value of variable SUM on the screen.

Use of Semicolon (;) with PRINT Statement

In PRINT statement, semicolon (;) between strings / variables / constants causes them to be printed right next to each other without any space between them.

Use of Comma (,) with PRINT Statement

In PRINT statement, comma (,) between strings / variables / constants causes them to be printed with equal spaces between them. Maximum of five values can be printed on single line using commas.

The following program shows the difference between semicolon and comma:

<table>
<thead>
<tr>
<th>Program</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>10 PRINT “Book”; “Urdu”; “Grade 8”</td>
<td>Book Urdu Grade 8</td>
</tr>
<tr>
<td>20 PRINT 123;456;789</td>
<td>123 456 789</td>
</tr>
<tr>
<td>30 PRINT “Book”, “Urdu”, “Grade 8”</td>
<td>Book Urdu Grade 8</td>
</tr>
<tr>
<td>40 PRINT “Lion”, “Whale”, “Monkey”, “Fish”</td>
<td>Lion Whale Monkey Fish</td>
</tr>
</tbody>
</table>

INPUT Statement

INPUT statement is used to take input from the user during the execution of the program.

Syntax:

Line number INPUT [Sequence of characters / string;] List of variables

Sequence of characters / string is used to prompt the user to enter the required value using keyboard and it is optional. List of variables are used to store the entered values.
**Example 1:** Program to find the square of a number

<table>
<thead>
<tr>
<th>Program</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10 CLS</td>
<td>Clear screen</td>
</tr>
<tr>
<td>20 INPUT X</td>
<td>Ask for input from the user</td>
</tr>
<tr>
<td>30 PRINT &quot;SQUARE of Your Number is = &quot; X^2</td>
<td>Print the string and square of entered number</td>
</tr>
</tbody>
</table>

RUN

Enter Number = 5

SQUARE of Your Number is = 25

| Prompt for user | Input from keyboard | Result is displayed on the screen |

**Example 2:** Program to find the area of a circle

<table>
<thead>
<tr>
<th>Program</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10 CLS</td>
<td>Clear screen</td>
</tr>
<tr>
<td>20 PIE=3.14</td>
<td>Assigns the value to the variable</td>
</tr>
<tr>
<td>30 INPUT &quot;Enter Radius&quot;; R</td>
<td>Ask the user to enter radius</td>
</tr>
<tr>
<td>40 A=PIE*R^2</td>
<td>Calculates the Area and assign it to variable A</td>
</tr>
<tr>
<td>50 PRINT &quot;The Area of the Circle = &quot;; A</td>
<td>Prints the string and the variable</td>
</tr>
</tbody>
</table>

RUN

Enter Radius? 7.4

The Area of the Circle is = 171.9464

| Prompt for user and Input from keyboard | Result is displayed on the screen |

**READ and DATA Statements**

READ and DATA statements are used when there is a need to process large number of variables with given data. READ statement defines the list of variables while DATA statement contains constant values for the variables in READ statements. Values in READ and DATA statements should be separated by commas.
**Syntax:**

- Line number **READ** List of Variables separated by commas
- Line number **DATA** List of Constants separated by commas

**Example:**

10 READ X, Y, Z, K  
20 DATA 8, 9, 13, 15

When the above program is executed, the line number 10 with the READ statement followed by the variables X, Y, Z, K will assign constant values from the DATA statement in line number 20 in the same order. A one-to-one correspondence exists in READ-DATA statements, i.e. X = 8, Y = 9, Z = 13, K = 15.

If values in the DATA statements are more than the variables in the READ statement then the extra values of DATA are ignored. But if the variables in READ statement are more than the values in the DATA statement then a syntax error encounters i.e. “Out of Data”.

**Example:**

<table>
<thead>
<tr>
<th>Program</th>
<th>Clear screen</th>
<th>Data statement with values</th>
<th>Reads four variables</th>
<th>Finds the sum numbers in the variable SUM1</th>
<th>Prints the values of variables on the screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>10  CLS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20  DATA 6, 15, 23, 44</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30  READ W, Y, X, Z</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40  SUM1 = W+Y+X+Z</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40  PRINT “Sum =“, SUM1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>RUN</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sum = 88</td>
<td></td>
</tr>
</tbody>
</table>
**IF-THEN-ELSE Statement**

IF...THEN is a decision making statement, depending upon the decision, it takes some action or changes the order of execution. It helps the computer to check whether a relation is TRUE or FALSE.

**Syntax:** IF relational expression THEN statement(s)1 ELSE statement(s)2

If the relational expression is true then statement(s)1 will be executed otherwise the statement(s)2 will be executed.

**Example:**

<table>
<thead>
<tr>
<th>Program</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>10 CLS</td>
<td>Clear screen</td>
</tr>
<tr>
<td>20 INPUT “ENTER FIRST VALUE”,A</td>
<td>Ask input for first value</td>
</tr>
<tr>
<td>30 INPUT “ENTER 2ND VALUE”, B</td>
<td>Ask input for second value</td>
</tr>
<tr>
<td>40 IF A&lt;B THEN SMALL = A ELSE SMALL = B</td>
<td>Compares the two values and stores the smaller number in the variable SMALL</td>
</tr>
<tr>
<td>50 PRINT “Smaller number = “; SMALL</td>
<td>Prints the string and the smaller number</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>RUN</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>ENTER FIRST VALUE 7</td>
<td>Ask for input for first value</td>
</tr>
<tr>
<td>ENTER 2ND VALUE 3</td>
<td>Ask for input for second value</td>
</tr>
<tr>
<td>Smaller number = 3</td>
<td>Output</td>
</tr>
</tbody>
</table>

**5.2.2 Assign a Variable to an Arithmetic Expression**

An assignment operator (=) is used to assign an arithmetic expression to a variable. The following are some examples to store arithmetic expressions into variables:

**Examples:**

10 PROD = 2*3*4*5
20 SUM = A + B
30 AVERAGE = SUM / 5

In the above examples PROD, SUM and AVERAGE are variables
which are used to assign respective expressions as given.

5.2.3 Sample Programs

Program 1: To find the sum and average of five given numbers

<table>
<thead>
<tr>
<th>Program</th>
<th>Clear screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>10  CLS</td>
<td>Assigns 0 to all variables to clear any previously stored values</td>
</tr>
<tr>
<td>20  A=0:B=0:C=0:D=0:E=0:SUM=0:AVG=0</td>
<td>Prompts the user to input for five numbers and stores them in variables A, B, C, D and E</td>
</tr>
<tr>
<td>30  INPUT “ENTER 1ST VALUE :“, A</td>
<td>Add the values stored in variables and assign them to the variable SUM</td>
</tr>
<tr>
<td>40  INPUT “ENTER 2ND VALUE :“, B</td>
<td>Calculates average by dividing SUM by 5 and stores it in AVG</td>
</tr>
<tr>
<td>50  INPUT “ENTER 3RD VALUE :“, C</td>
<td>Prints the result of sum</td>
</tr>
<tr>
<td>60  INPUT “ENTER 4TH VALUE :“, D</td>
<td>Prints the result of average</td>
</tr>
<tr>
<td>70  INPUT “ENTER 5TH VALUE :“, E</td>
<td></td>
</tr>
<tr>
<td>80  SUM = A + B + C + D + E</td>
<td></td>
</tr>
<tr>
<td>90  AVG = SUM/5</td>
<td></td>
</tr>
<tr>
<td>100 PRINT “SUM = “; SUM</td>
<td></td>
</tr>
<tr>
<td>110 PRINT “AVERAGE = “; AVG</td>
<td></td>
</tr>
</tbody>
</table>

The output of the above program is shown in Figure 5.9

![Figure 5.9 Output of Program 1](image-url)
Program 2: To find the product of five given numbers

Program

```
10 CLS
20 INPUT “ENTER 1ST VALUE: “, A
30 INPUT “ENTER 2ND VALUE: “, B
40 INPUT “ENTER 3RD VALUE: “, C
50 INPUT “ENTER 4TH VALUE: “, D
60 INPUT “ENTER 5TH VALUE: “, E
70 PROD = A * B * C * D * E
80 PRINT “PRODUCT = “; PROD
```

Clear screen
Prompts the user to input for five numbers and stores them in variables A, B, C, D and E
Calculates product of five number by multiply the values stored in variables and stores the result in PROD
Prints the result of product

The output of the above program is shown in Figure 5.10

![Figure 5.10 Output of Program 2](image-url)
Program 3: To display the larger one out of the two given unequal numbers

<table>
<thead>
<tr>
<th>Program</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>CLS</td>
</tr>
<tr>
<td>20</td>
<td>INPUT “Enter two unequal numbers:”, p, q</td>
</tr>
<tr>
<td>30</td>
<td>IF p &gt; q THEN PRINT “The greater of the two numbers is =”, p</td>
</tr>
<tr>
<td></td>
<td>ELSE PRINT “The greater of the two numbers is =”, q</td>
</tr>
</tbody>
</table>

Clear screen

Prompts the user to input for two numbers and stores them in variables p and q

Compares the two values and stores the bigger number in the variable BIG

If comparison returns true is returned THEN part is executed if false is returned ELSE part is executed.

The output of the above program is shown in Figure 5.11

![Figure 5.11 Output of Program 3](C:\DOCUME~1\shaliq\Desktop\GVBASIC3.EXE)
**Program 4:** To find the area of a rectangular region with given length and width

<table>
<thead>
<tr>
<th>Program</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
</tr>
<tr>
<td>20</td>
</tr>
<tr>
<td>30</td>
</tr>
<tr>
<td>40</td>
</tr>
<tr>
<td>50</td>
</tr>
<tr>
<td>60</td>
</tr>
</tbody>
</table>

- **Clear screen**
- **Assigns 0 to all variables to clear any previously stored values**
- **Prompts the user to input length and width and stores them in variables L and W**
- **Calculates area and stores it in AREA**
- **Prints the result**

The output of the above program is shown in Figure 5.12

![Figure 5.12 Output of Program 4](image)

**Program 5:** To find the area of a circular region with given radius

<table>
<thead>
<tr>
<th>Program</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
</tr>
<tr>
<td>20</td>
</tr>
<tr>
<td>30</td>
</tr>
<tr>
<td>40</td>
</tr>
<tr>
<td>50</td>
</tr>
</tbody>
</table>

- **Clear screen**
- **Assigns 3.14159 to PIE and 0 to variables R and AREA to clear any previously stored values**
- **Prompts the user to input radius and stores it in R**
- **Calculates area and stores it in AREA**
- **Prints the result**
The output of the above program is shown in Figure 5.13

![Figure 5.13 Output of Program 5](image)

**Program 6:** To convert Celsius to Fahrenheit using appropriate formula.

<table>
<thead>
<tr>
<th>Program</th>
<th></th>
</tr>
</thead>
</table>
| 10        | CLS
| 20        | C = 0 : F = 0
| 30        | INPUT " ENTER TEMPERATURE IN CELSIUS : " ; C
| 40        | F = C * 9 / 5 + 32
| 50        | PRINT " TEMPERATURE IN FAHRENHEIT = " ; F

Clear screen
Assigns 0 to variables C and F to clear any previously stored values
Prompts the user to input two values
stores them in variables C and F
Calculates the Fahrenheit equivalent to Celsius temperature and stores it in F
Prints the result

The output of the above program is shown in Figure 5.14

![Figure 5.14 Output of Program 6](image)
Program 7: To convert Fahrenheit to Celsius using appropriate formula.

<table>
<thead>
<tr>
<th>Program</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10 CLS</td>
<td>Clear screen</td>
</tr>
<tr>
<td>20 C = 0 : F = 0</td>
<td>Assigns 0 to variables C and F to clear any previously stored values</td>
</tr>
<tr>
<td>30 INPUT &quot;ENTER TEMPERATURE IN FAHRENHEIT :&quot;, F</td>
<td>Prompts the user to input two values stores them in variables C and F</td>
</tr>
<tr>
<td>40 C = (F-32) * 5 / 9</td>
<td>Calculates the Celsius equivalent to Fahrenheit temperature and stores it in C</td>
</tr>
<tr>
<td>50 PRINT &quot;TEMPERATURE IN CELSIUS =&quot;, C</td>
<td>Prints the result</td>
</tr>
</tbody>
</table>

The output of the above program is shown in Figure 5.15

*Figure 5.15 Output of Program 7*
SUMMARY

Computer Programming

- Programming is a technique to develop programs. Different programming languages are used to write programs.
- A computer program is a sequence of instructions given to the computer to perform a specific task.
- Programming language is a language designed to develop programs or instructions to communicate with the computer to solve various problems.
- Constants are the quantities whose values cannot be changed during program execution or running.
- Variable is a named space in the computer's memory whose value can be changed during the execution of a program. Variables give meaningful names to constants.
- Numeric variables are used to store numeric constants such as 10, 134, 12.34 and –312, etc.
- String variables are used to store sequence of characters or strings enclosed in double quotations. String variables can store string constants.
- The syntax of a programming language is the set of rules that define the combination of symbols used by that language.
- A syntax error occurs when the instructions written in a program do not follow the rules of the programming language.
- A logical error is an error resulting in wrong answer due to programmers own logical mistake. These errors occur due to wrong use of formulae or providing wrong value to a variable.
- An expression is a combination of symbols and operators that represents a value. Every expression consists of at least one operand and can have one or more operators.
Operators are symbols that indicate the type of operation to be performed on the data.

The three common types of operators are Arithmetic Operators, Relational Operators and Logical Operators.

Arithmetic Operators are used to perform mathematical calculations like addition, subtraction, division, multiplication and exponentiation.

Precedence is the priority that is followed while applying operators in an expression.

An operator which is used to assign a value to a variable is called Assignment Operator. In programming languages “Equal sign” (=) is used as an assignment operator.

Relational Operators are used to perform comparisons on two values.

BASIC stands for Beginner's All purpose Symbolic Instruction Code.

Commands are key words which are used to issue instructions to the computer to perform specific tasks.

CLS command is used to clear the contents of the screen.

List command shows the list of all or part of a loaded program on the screen. F1 key is used as a shortcut key for LIST command.

RUN command is used to execute (get result) of the program. F2 key is used as a shortcut key for RUN command.

Load command is used to load (open) a file from any storage medium like Hard Disk into the main memory of the computer. F3 key is used as a shortcut key for LOAD command.

SAVE command is used to save the program in the Hard Disk or any other storage media. F4 key is used as a shortcut key for SAVE command.

Statements are the instructions for the computer program to perform an action.
- The PRINT statement is used to display message or output to the screen.
- INPUT statement is used to take input from the user during the execution of the program.
- READ statement defines the list of variables while DATA statement contains constant values for the variables in READ statements.
- IF...THEN is a decision making statement, depending upon the decision, it takes some action or changes the order of execution.
- An assignment operator (=) is used to assign an arithmetic expression to a variable.

Q1. **Tick the correct choice for the following questions.**

i. A sequence of instructions given to the computer to perform a specific task is called _____________.
   a. Data
   b. Program
   c. Programming
   d. Information

ii. What is a named space in the computer's memory whose value can be changed during the execution of a program?
   a. Variable
   b. Constant
   c. Program
   d. Data
iii. In BASIC programming language which character is used as a last character with string variable?
   a. ?
   b. &
   c. %
   d. $

iv. Which shortcut key is used to apply RUN command in GWBASIC?
   a. F1
   b. F2
   c. F3
   d. F4

v. Which of the following error cannot be detected by a computer?
   a. Syntax error
   b. Run time error
   c. Logical error
   d. Execution error

vi. Which of the following is a logical operator?
   a. +
   b. –
   c. >
   d. /

vii. Which of the following operator has the highest priority?
   a. +
   b. ^
   c. –
   d. *
viii. If A=5, B=3 and C=2, what will be the answer of the following expression? Exp = A + B * C
a. 10
b. 11
c. 13
d. 16

ix. Which of the following statements is used to accept data from the user during program execution?
a. PRINT
b. LOAD
c. READ-DATA
d. INPUT

x. The set of rules that define the combination of symbols used by programming languages is called _____________.
a. Syntax
b. Data
c. Program
d. Logic

Q2. **Fill in the blanks.**

i. ________________ languages are the means of communication between users and the computer.

ii. ________________ are the quantities whose values cannot be changed during program execution or running.

iii. In a program the occurrence of incorrect or unexpected result is called ________________.

iv. A ________________ error is an error resulting in wrong answer due to programmers own mistake.

v. ________________ are symbols that represent particular actions in an expression.
vi. An operator which is used to assign a value to a variable is called _____________.

vii. BASIC stands for _____________________________________________.

viii. In BASIC language, program line number is a positive _________.

ix. ________________ are key words which are used to issue instructions to the computer to perform specific tasks.

x. In GWBASIC, ____________ command is used to clear the screen.

Q3. **Match Column A with Column B.**

<table>
<thead>
<tr>
<th>Column A</th>
<th>Column B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constants</td>
<td>MOD</td>
</tr>
<tr>
<td>Variables</td>
<td>READ-DATA</td>
</tr>
<tr>
<td>Arithmetic Operator</td>
<td>SAVE</td>
</tr>
<tr>
<td>Relational Operator</td>
<td>Changeable Quantities</td>
</tr>
<tr>
<td>Command</td>
<td>&lt;&gt;</td>
</tr>
<tr>
<td>Statement</td>
<td>Not changeable Quantities</td>
</tr>
</tbody>
</table>

Q4. **Give brief answers to the following questions.**

i. What is a program? Give few examples of programs.

ii. What is the purpose of a programming language?

iii. Differentiate between a constant and a variable.

iv. Differentiate between Syntax error and logical error.

v. What are the rules for defining / declaring variables in GWBASIC?

vi. Name different types of constants with examples.

vii. Give the precedence of arithmetic operators?

viii. What is purpose of modulus operator (MOD)?
ix. What is the purpose of the following GWBASIC commands?
   a. LIST  b. RUN  c. LOAD  d. SAVE

Q5. Give detailed answers to the following questions.
   i. Explain different types of errors in programming with examples.
   ii. What is arithmetic expression? Explain different types of operators with examples.
   iii. Convert the following algebraic expressions into computer expressions.
         a. (AB) + (BC)
         b. 5X – 7Y
         c. A ÷ B x C3
         d. B2 – 4AC
         e. XY ÷ (X – Y)
   iv. Find solution for the following expressions, if A=3, B=4 and C=5
         a. C – A * B – 5
         b. (A + B) – C^2
         c. (B + C) / A * 10
         e. C MOD A * B + C
   v. Explain the purpose of the following BAISC statements with their syntax and examples.
      a. PRINT
      b. INPUT
      c. READ and DATA
      d. IF-THEN-ELSE
Write a program in GWBASIC to input weight of your five friends with their names. Find the average weight and produce the output.

Measure the length and width of top of your desk. Write a program to input the length and the width and calculate the area of the top of your desk. Print the area as output.

Write a program to read five variables using READ statement for five subjects i.e. English, Urdu, Maths, Science and Computer Education. Give data for these variables using DATA statement. Find the total of subject marks and print it.

Write a program to input two unequal numbers. Use IF-THEN-ELSE statement to find the bigger number and print it.

Write a program to input radius of a circle in variable R and find the area of it using the formula, AREA = PIE * R*R, where PIE = 3.1415. Print the area as output.
UNIT 1

Q1. **Tick the correct choice.**
   i. c. Computers
   ii. d. Transmission media
   iii. b. Modem
   iv. b. Sending device
   v. d. LAN
   vi. c. Wide
   vii. a. Server
   viii. a. Network Interface Card
   ix. d. Coaxial cable
   x. c. Fiber optic cable

Q2. **Fill in the blanks.**
   i. Four
   ii. Receiving
   iii. Transmission Media
   iv. Client
   v. Metropolitan Area Network
   vi. Wide Area Network
   vii. Network Interface Card
   viii. Bluetooth
   ix. Fiber Optic
   x. Global Positioning System (GPS)

Q3. **Match Column A with Column B.**

<table>
<thead>
<tr>
<th>Column A</th>
<th>Column B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sending Device</td>
<td>Coaxial Cable</td>
</tr>
<tr>
<td>Communication Device</td>
<td>NIC</td>
</tr>
<tr>
<td>Transmission Media</td>
<td>Glass threads</td>
</tr>
<tr>
<td>Network</td>
<td>A Computer</td>
</tr>
<tr>
<td>Fiber Optic</td>
<td>Modem</td>
</tr>
</tbody>
</table>

UNIT 2

Q1. **Tick the correct choice.**
   i. b. Worm
   ii. c. Adware
   iii. d. Insecure website
   iv. c. Antivirus program
   v. a. Virus definition file
   vi. a. Infected flash drives or disks
   vii. b. Hacking
Q2. Fill in the blanks.

i. e-mail attachment
ii. hackers
iii. threats
iv. Pirated software
v. Adware

Q3. Match Column A with Column B.

<table>
<thead>
<tr>
<th>Column A</th>
<th>Column B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virus</td>
<td>Current viruses</td>
</tr>
<tr>
<td>Hacker</td>
<td>Malicious program</td>
</tr>
<tr>
<td>Pirated Software</td>
<td>Steals Password</td>
</tr>
<tr>
<td>Virus Definitions</td>
<td>AVG</td>
</tr>
<tr>
<td>Antivirus</td>
<td>Illegal Copying</td>
</tr>
</tbody>
</table>

UNIT 3

Q1. Tick the correct choice.

i. a. Top Left
ii. c. Seven
iii. c. Cell
iv. d. Excel
v. a. Quick Access Toolbar
vi. b. Three
vii. b. Columns
viii. c. Active Cell
ix. a. Cell address
x. b. Moves the contents from one cell to another location

Q2. Fill in the blanks.

i. Spreadsheet
ii. Workbook
iii. Worksheet
iv. Quick Access Toolbar
v. Formula
vi. Name
vii. Cell Range
viii. Auto filling
ix. Formula
x. Functions
xi. MAX
xii. Clipboard
xiii. Font
xiv. Charts
Q3. **Match Column A with Column B.**

<table>
<thead>
<tr>
<th>Column A</th>
<th>Column B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spreadsheet</td>
<td>Currently used cell</td>
</tr>
<tr>
<td>Ribbon</td>
<td>Cell reference</td>
</tr>
<tr>
<td>Active Cell</td>
<td>Fill handle</td>
</tr>
<tr>
<td>Name box</td>
<td>Excel</td>
</tr>
<tr>
<td>Auto-filling</td>
<td>Command Tab</td>
</tr>
<tr>
<td>Predefined formula</td>
<td>Function</td>
</tr>
</tbody>
</table>

**UNIT 4**

Q1. **Tick the correct choice.**

i. c. 3

ii. a. Problem Solving

iii. d. Problem

iv. a. Input

v. b. Output

vi. c. Diamond

vii. a. Terminal

viii. b. Rectangle

Q2. **Fill in the blanks.**

i. Problem solving

ii. Problem statement

iii. Processing requirements

iv. Flowcharting

v. Parallelogram

Q3. **Match Column A with Column B.**

<table>
<thead>
<tr>
<th>Column A</th>
<th>Column B</th>
</tr>
</thead>
<tbody>
<tr>
<td>A problem</td>
<td>What is given</td>
</tr>
<tr>
<td>A problem Statement</td>
<td>Diagram to represent a process</td>
</tr>
<tr>
<td>The Input</td>
<td>What is required</td>
</tr>
<tr>
<td>Flowchart</td>
<td>A hurdle</td>
</tr>
<tr>
<td>The Output</td>
<td>A concise description of the problem</td>
</tr>
</tbody>
</table>
UNIT 5

Q1. *Tick the correct choice.*

i. b. Program  
   iii. d. $  
   v. c. Logical error  
   vii. b. ^  
   ix. d. INPUT  
   ii. a. Variable  
   iv. b. F2  
   vi. c. >  
   viii. b. 11  
   x. a. Syntax

Q2. *Fill in the blanks.*

i. Programming  
   iii. Error  
   v. Operators  
   vii. Beginner's All purpose Symbolic Instruction Code  
   viii. Integer  
   x. CLS  
   ii. Constants  
   iv. Logical error  
   vi. Assignment Operator  
   ix. Commands

Q3. *Match Column A with Column B.*

<table>
<thead>
<tr>
<th>Column A</th>
<th>Column B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constants</td>
<td>MOD</td>
</tr>
<tr>
<td>Variables</td>
<td>READ-DATA</td>
</tr>
<tr>
<td>Arithmetic Operator</td>
<td>SAVE</td>
</tr>
<tr>
<td>Relational Operator</td>
<td>Changeable Quantities</td>
</tr>
<tr>
<td>Command</td>
<td>&lt;&gt;</td>
</tr>
<tr>
<td>Statement</td>
<td>Not changeable Quantities</td>
</tr>
</tbody>
</table>
**A**

**Active Cell:** The active cell is the cell which is currently selected in a worksheet.

**Adware:** Adware is a software which automatically plays, displays, or downloads advertisements to a computer usually without user's knowledge. These advertisements can be in the form of a pop-up.

**Antivirus Software:** Antivirus software is a computer program that detects, prevents, and takes action to deactivate or remove malicious programs (Viruses, Worms, and Adware, etc.).

**Arithmetic Operators:** Arithmetic Operators are used to perform mathematical calculations like addition, subtraction, division, multiplication and exponentiation.

**Assignment Operator:** An operator which is used to assign a value to a variable is called Assignment Operator. In programming languages “Equal sign” (=) is used as an assignment operator.

**Auto filling:** Auto filling is the use of the fill-handle to copy data and sequences across a range of cells. The fill-handle is at the right corner of each cell.

**AVG Antivirus:** AVG is antivirus software developed by AVG Technologies, a private Czech company formerly known as Grisoft. It provides Internet security for the Windows, Linux and Mac OS X. AVG stands for Antivirus Guard.

**B**

**Bluetooth:** Bluetooth is a wireless technology for exchanging data between different devices over short distances.

**Borders:** Borders are outlines around the cell or cells in a worksheet.

**C**

**Cell Address or Cell Reference:** Cell Address or Cell Reference identifies the location of a cell or group of cells in a worksheet. It consists of the column letter and row number that intersect at the cell’s location.

**Cell Range:** Selecting more than one cells in a worksheet is known as a cell range.

**Cell:** The intersection of row and column in a worksheet is called cell. Cell is the basic unit in the worksheet where user can enter data, function or formula.

**Cellular Communication:** Cellular communication is a radio communication that offers communication services to thousands of cell phone users around the globe.
**Charts:** Charts are the graphical representation of data entered in a worksheet. Charts are helpful in showing the comparison between different categories.

**Client:** Client is a less powerful computer as compared to server computer. It relies on servers for resources, such as files, devices, and even processing power.

**CLS Command:** CLS command is used to clear the contents of the screen.

**Coaxial Cable:** Coaxial cable is a type of wire that consists of a center wire surrounded by insulation and a shield of braided wire.

**Columns:** Columns in a worksheet are arranged vertically. They are identified by alphabet in the column header from A to Z, AA, AB, AC, to XFD.

**Commands:** Commands are key words which are used to issue instructions to the computer to perform specific tasks.

**Communication Devices:** Communication devices are used for communication between the computers and other devices.

**Computer Network:** A computer network is interconnection of two or more computer systems located in a same room, building or at different places.

**Computer Virus:** Computer virus is the most common and well known computer security threat. A computer virus is a program written intentionally to alter the way a computer operates, without the permission or knowledge of the user.

**Computer Worms:** Computer worms are malicious programs that replicate and spread independently and harm the computer.

**Constants:** Constants are the quantities whose values cannot be changed during program execution or running.

**Copy-Paste:** The Copy-Paste option is used to take the duplicate of the selected cell contents by copying them and pasting them where required. This option does not remove the text from the source location.

**Cut-Paste:** The Cut-Paste or Move option is used to move text from one place (source) to another place (destination).

**Data Manipulation:** Data manipulation involves entering, editing and formatting data.

**Dialup MODEM:** A Dialup MODEM (Modulator-Demodulator) is a communication device used to connect to the Internet, exchange information, and to send and receive data from one computer to the other.
**Data:** Editing data means doing any changes in it.

**Excel Screen:** Excel screen is in the form of a rectangular table or grid of rows and columns. The horizontal rows are identified by numbers (1, 2, 3, ...) and the vertical columns with alphabet (A, B, C or AA, AB, etc).

**Excel:** Excel is one of the popular and commonly used spreadsheet software.

**Expression:** An expression is a combination of symbols and operators that represents a value. Every expression consists of at least one operand and can have one or more operators.

**Fiber Optic Cable:** Fiber Optic is a type of cable that uses glass (or plastic) threads to transmit data.

**Flowchart:** A flowchart is a type of diagram that represents a process, showing the steps as symbols of various kind and their order by connecting them with arrows.

**Flowcharting:** Flowcharting is a process of pictorial illustration for solving a problem.

**Font:** Font is the typeface of text and it is a set of characters used in typing of text in a particular style.

**Formatting:** Changing the appearance of a cell’s content is known as formatting. Formatting data makes the work more beautiful and more readable.

**Formula Bar:** Formula bar displays the contents of the active cell and the formulae as user types them in an active cell.

**Formula:** Formula is an equation that performs a calculation using values in the worksheet. A formula always begins with an equals sign followed by either values or cell references and an operator.

**Functions:** Functions are pre-defined or built-in formulae.

**Global Positioning System:** The Global Positioning System (GPS) is global navigation satellite system. This direction-finding system uses satellites to determine precise locations on the surface of the Earth.

**Hacker:** People who indulge themselves in hacking activities are called hackers.
**Hacking:** Hacking can be defined as the unauthorized use of computer, network and its resources.

**IF...THEN Statement:** IF...THEN is a decision making statement, depending upon the decision, it takes some action or changes the order of execution.

**INPUT Statement:** INPUT statement is used to take input from the user during the execution of the program.

**Input:** Input is such element of the problem statement that we give to the computer as raw material to solve the problem.

**List Command:** List command shows the list of all or part of a loaded program on the screen. F1 key is used as a shortcut key for LIST command.

**Load Command:** Load command is used to load (open) a file from any storage medium like Hard Disk into the main memory of the computer. F3 key is used as a shortcut key for LOAD command.

**Local Area Network (LAN):** A Local Area Network (LAN) is a network that is confined to a relatively small area.

**Logical Error:** A logical error is an error resulting in wrong answer due to programmers own logical mistake. These errors occur due to wrong use of formulae or providing wrong value to a variable.

**McAfee Virus Scan:** McAfee Virus Scan is an antivirus program created and maintained by McAfee Incorporated. McAfee antivirus offers effective security to the computer from attacks of malware.

**Metropolitan Area Network or MAN:** A large computer network which extends to a city or to a metropolitan region is termed as Metropolitan Area Network or MAN.

**Modem:** Modem is a popular communication device which is used for Internet communication.

**Name Box:** Name Box displays the reference of the active cell.

**Network Interface Card (NIC):** Network Interface Card is an expansion card that enables a computer to connect to a network.
**Operators:** Operators are symbols that indicate the type of operation to be performed on the data.

**Output:** Output is the result which is obtained by processing the input data. It is also called the solution.

**Pirated Software:** Software which has been duplicated and distributed without authorization is called Pirated software. Pirated software may be faulty or loaded with malware and may contain viruses.

**PRINT Statement:** PRINT statement is used to display message or output to the screen.

**Problem Statement:** A problem statement is a concise description of the problem to be solved. It is a good idea to state a problem before trying to solve it.

**Problem:** A problem is an obstacle, hurdle, difficulty or challenge, or any situation that needs to be removed or solved.

**Problem Solving:** Problem solving is a process to solve different types of problems. The goal of problem solving is to get the desired result in a short and perfect manner.

**Processing Requirements:** The Processing requirements involve performing actions or operations on input data to achieve the desired goals and find the solution to the problem.

**Program:** A computer program is a sequence of instructions given to the computer to perform a specific task.

**Programming Language:** A programming language is a language designed to develop programs or instructions to communicate with the computer to solve various problems.

**Programming:** Programming is a technique to develop programs. Different programming languages are used to write programs.

**READ Statement:** READ statement defines the list of variables while DATA statement contains constant values for the variables in READ statements.

**Receiving Device:** In a computer network a receiving device receives messages, data or information from a sending device.

**Relational Operators:** Relational Operators are used to perform comparisons on two values.
Rows: Rows are arranged horizontally in a worksheet. They are identified by numbers in the row header (i.e. 1, 2, 3, 4, ...).

RUN Command: RUN command is used to execute (get result) of the program. F2 key is used as a shortcut key for RUN command.

Satellite Communication: Satellite Communication is a form of wireless communication system in which satellites are ideally placed to provide telecommunication links between different places across the globe. These satellites enable us to communicate over large distances.

SAVE Command: SAVE command is used to save the program in the Hard Disk or any other storage media. F4 key is used as a shortcut key for SAVE command.

Security Threat: Computer security threat may be a computer program, an event or even a person which causes loss of data, affecting the working of a computer and stealing of information.

Sending Device: A device which is used to send messages, data or information to other devices connected to a network is called a sending device.

Server: Server is a powerful computer that facilitates the whole network by providing variety of services to the computer or devices connected to the network.

Spreadsheet: A spreadsheet is a computer application which is used to display data in multiple cells usually in a two-dimensional matrix or grid consisting of rows and columns.

Statements: Statements are the instructions for the computer program to perform an action.

Symantec Antivirus (SAV): Symantec Antivirus (SAV) is a very powerful effective program, which can protect computers from different kinds of safety issues.

Syntax Error: A syntax error occurs when the instructions written in a program do not follow the rules of the programming language.

Syntax: The syntax of a programming language is the set of rules that define the combination of symbols used by that language.

Text Formatting: Text formatting includes formatting the font size, style, and colour; and using the Bold, Italic, Underline, and Aligning the text.
**Transmission Media:** Transmission Media is the channel or path through which the data or information is transferred from one place to another in a computer network.

**Rows:** Rows are arranged horizontally in a worksheet. They are identified by numbers in the row header (i.e. 1, 2, 3, 4, ...).

**Twisted Pair Cables:** Twisted Pair cables are the most popular transmission media for transferring data on a computer network.

**V**

**Variable:** Variable is a named space in the computer's memory whose value can be changed during the execution of a program. Variables give meaningful names to constants.

**Virus Definitions:** Virus Definitions contain the information about malware which can be used to identify them.

**W**

**Wide Area Network (WAN):** Wide Area Network is a very large computer network covering a large geographic area, such as a state, province, country or the whole world.

**Workbook:** A Workbook is a file created by Excel spreadsheet application. Excel workbooks are actually sets of spreadsheet 'pages', each of which can include separate data.
http://scienceray.com/technology/data-communication/
http://blogpcnet.blogspot.com/2010/05/network-types-1.html
http://www.networkingtipsblog.com/networking/lan-computer-network/
http://network-classification.blogspot.com/
http://en.wikipedia.org
http://www.mohacks.com/video-computer-virus-halloween-prank
http://www.theoffside.com
http://www.softwaredistrict.com
http://avirus66.wordpress.com/
http://people.usd.edu/~bwjames/tut/excel/
http://www.free-training-tutorial.com/
http://www.easyexceltutorial.com/
http://www.exceltutorial.org/
http://spreadsheets.about.com/
http://www.businessprocessidea.com/problem-solving-process/
http://mathgames.4you4free.com/problem_sloving_logic.html
http://flowchart.com/
http://www.rff.com/flowchart_samples.htm
http://www.webopedia.com/TERM/P/programming_language.html
http://www.cs.waikato.ac.nz/~marku/languages.html
http://www.justbasic.com/
http://tedfelix.com/qbasic/
http://pages.intnet.mu/jhbpage/Program/Qbasic/tutorial/index.htm
<table>
<thead>
<tr>
<th>A</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active cell</td>
<td>50</td>
</tr>
<tr>
<td>Adware</td>
<td>26</td>
</tr>
<tr>
<td>Antivirus</td>
<td>30</td>
</tr>
<tr>
<td>Arithmetic Expression</td>
<td>109</td>
</tr>
<tr>
<td>Arithmetic Operators</td>
<td>110</td>
</tr>
<tr>
<td>Assignment Operator</td>
<td>112</td>
</tr>
<tr>
<td>Auto filling data</td>
<td>52</td>
</tr>
<tr>
<td>AVERAGE Funtion</td>
<td>57</td>
</tr>
<tr>
<td>AVG Antivirus</td>
<td>33</td>
</tr>
<tr>
<td>B</td>
<td>Page</td>
</tr>
<tr>
<td>BASIC language</td>
<td>113</td>
</tr>
<tr>
<td>Bluetooth</td>
<td>15</td>
</tr>
<tr>
<td>Borders</td>
<td>72</td>
</tr>
<tr>
<td>C</td>
<td>Page</td>
</tr>
<tr>
<td>Cell</td>
<td>50</td>
</tr>
<tr>
<td>Cell Address</td>
<td>50</td>
</tr>
<tr>
<td>Cell Range</td>
<td>51</td>
</tr>
<tr>
<td>Cell Reference</td>
<td>50</td>
</tr>
<tr>
<td>Cellular Communication</td>
<td>13</td>
</tr>
<tr>
<td>Charts</td>
<td>75</td>
</tr>
<tr>
<td>Client</td>
<td>5</td>
</tr>
<tr>
<td>Coaxial Cable</td>
<td>11</td>
</tr>
<tr>
<td>Columns</td>
<td>50</td>
</tr>
<tr>
<td>Commands</td>
<td>114</td>
</tr>
<tr>
<td>Computer Networks</td>
<td>2</td>
</tr>
<tr>
<td>Computer Security Threats</td>
<td>24</td>
</tr>
<tr>
<td>Constants</td>
<td>107</td>
</tr>
<tr>
<td>Copy – Paste</td>
<td>65</td>
</tr>
<tr>
<td>Cut – Paste</td>
<td>66</td>
</tr>
<tr>
<td>Cutting Edge Technologies</td>
<td>12</td>
</tr>
<tr>
<td>D</td>
<td>Page</td>
</tr>
<tr>
<td>Dialup MODEM</td>
<td>8</td>
</tr>
<tr>
<td>E</td>
<td>Page</td>
</tr>
<tr>
<td>Editing data</td>
<td>52</td>
</tr>
<tr>
<td>E-mail Attachments</td>
<td>28</td>
</tr>
<tr>
<td>Error</td>
<td>108</td>
</tr>
<tr>
<td>Excel</td>
<td>45</td>
</tr>
<tr>
<td>F</td>
<td>Page</td>
</tr>
<tr>
<td>Fiber Optic Cable</td>
<td>12</td>
</tr>
<tr>
<td>Flowchart</td>
<td>93</td>
</tr>
<tr>
<td>Flowchart Symbols</td>
<td>93-94</td>
</tr>
<tr>
<td>Flowcharting</td>
<td>92</td>
</tr>
<tr>
<td>Font</td>
<td>68</td>
</tr>
<tr>
<td>Formatting</td>
<td>64</td>
</tr>
<tr>
<td>Formatting Text</td>
<td>67</td>
</tr>
<tr>
<td>Formula</td>
<td>53</td>
</tr>
<tr>
<td>Formula Bar</td>
<td>48</td>
</tr>
<tr>
<td>Functions</td>
<td>55</td>
</tr>
<tr>
<td>G</td>
<td>Page</td>
</tr>
<tr>
<td>Global Positioning System (GPS)</td>
<td>14</td>
</tr>
<tr>
<td>H</td>
<td>Page</td>
</tr>
<tr>
<td>Hackers</td>
<td>27</td>
</tr>
<tr>
<td>Hacking</td>
<td>27</td>
</tr>
<tr>
<td>I</td>
<td>Page</td>
</tr>
<tr>
<td>Input</td>
<td>91</td>
</tr>
<tr>
<td>Insecure websites</td>
<td>29</td>
</tr>
<tr>
<td>L</td>
<td>Page</td>
</tr>
<tr>
<td>LIST Command</td>
<td>115</td>
</tr>
<tr>
<td>LOAD Command</td>
<td>117</td>
</tr>
<tr>
<td>Local Area Network (LAN)</td>
<td>5</td>
</tr>
<tr>
<td>Logical Error</td>
<td>109</td>
</tr>
<tr>
<td>M</td>
<td>Page</td>
</tr>
<tr>
<td>MAX Function</td>
<td>58</td>
</tr>
</tbody>
</table>